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What Is Simulink Parameter Estimation?

What Is Simulink Parameter Estimation?

Simulink® Parameter Estimation is a Simulink-based product for estimating
and calibrating model parameters from experimental data. This product
supports

¢ Transient Estimation — Estimate parameters by comparing model output
to the experimental data for a given input.

e Initial Condition Estimation — Estimate the initial conditions of states
using experimental data.

¢ Adaptive Lookup Tables — Estimate the table values at the prescribed
breakpoints by using measurements from the physical system.

Simulink Parameter Estimation provides the tools used to

1 Set up the problem.
2 Specify which model parameters to estimate.

3 Import and prepare the experimental data for parameter estimation (or
preprocess).

4 View the estimation progress.

5 Validate the estimation results based on plots of measured versus.
simulated data and residuals.
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What You Need to Get Started

In this section...

“Prerequisite Software and Optional Software” on page 1-4

“Required Knowledge” on page 1-4

“Demos” on page 1-4

Prerequisite Software and Optional Software

Simulink Parameter Estimation requires MATLAB®, Simulink, and the
Optimization Toolbox.

The MathWorks provides several products that are relevant to the kinds
of task you can perform with Simulink Parameter Estimation. For more
information about any of these products, see the

e MathWorks Web site at
http://www.mathworks.com/products/simparameter/related.jsp

¢ Online documentation for related products, if they are installed on your
system

Required Knowledge

It is not necessary that you have a strong background in optimization theory
or practice. As you gain familiarity with Simulink Parameter Estimation, you
might find it helpful to consult the Optimization Toolbox documentation for
more details about optimization algorithms.

Demos

Simulink Parameter Estimation provides demonstration files that show you
how to use the blockset to perform control design tasks in various settings. To
run these demos, type

demo

at the MATLAB prompt. This opens the Demos pane in the Help browser.
Select Simulink > Simulink Parameter Estimation to list the available


http://www.mathworks.com/products/simparameter/related.jsp

What You Need to Get Started

demos. Alternatively, if you have the Help browser open, you can select the
Demos pane in the Help browser and then select Simulink > Simulink
Parameter Estimation.
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How Simulink Parameter Estimation Works

In this section...

“Basic Steps in the Estimation Process” on page 1-6
“Structure of an Estimation Project” on page 1-7

“Adding, Deleting and Renaming an Estimation Project” on page 1-7

Basic Steps in the Estimation Process

Simulink Parameter Estimation compares empirical data with data generated
by a Simulink model. Using optimization techniques, Simulink Parameter
Estimation estimates the parameter and (optionally) initial conditions of
states such that a user-selected cost function is minimized. The cost function
typically calculates a least-square error between the empirical and model
data signals.

After you build a Simulink model, follow these steps to configure and run a
parameter estimation:

1 Select Tools > Parameter Estimation in your Simulink model window.

This opens the Control and Estimation Tools Manager, creates a new
project, and adds an Estimation node to the workspace directory tree.

2 Import the input and output data set for estimating parameters of your
Simulink model.

3 Select the parameters and initial conditions you want to estimate.
4 Configure the estimation itself, including cost functions and data views.
5 Run the estimation.

6 Check the results by examining either the cost-function values, plots, or
parameter values.
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Structure of an Estimation Project

The Control and Estimation Tools Manager, which is a graphical user
interface (GUI) for performing parameter estimation, stores and organizes
all data from a given Simulink model inside a project. To open the Control
and Estimation Tools Manager GUI, select Tools > Parameter Estimation
in the Simulink model window. See Control and Estimation Tools Manager
GUI on page 1-10 for a picture showing this GUI.

When using the Control and Estimation Tools Manager for parameter
estimation, you can

* Manage estimation projects.

¢ Select parameters and initial conditions to configure the estimation.
® Specify cost functions.

¢ Import experimental data (to be matched by the output of your Simulink
model).

¢ Specify the initial conditions of your model.
Each estimation task can include

® One or more data sets

¢ Parameter information

® One or more sets of estimation settings, or configurations

The default project name is the same as the Simulink model name. The

project name is shown in the workspace directory tree of the Control and
Estimation Tools Manager.

You can also add tasks from Simulink Control Design and Model Predictive

Control Toolbox to the current project, if these products are installed on your
system.

Adding, Deleting and Renaming an Estimation Project

To add, delete, or rename the project or task:

1 Right-click the project or task node in the workspace directory tree.
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2 Select the appropriate command from the shortcut menu.



Setting Up the Estimation Data

Setting Up the Estimation Data

In this section...

“Creating an Estimation Project” on page 1-9
“Importing Transient Data” on page 1-11
“Specifying Initial Conditions” on page 1-14
“Selecting Parameters for Estimation” on page 1-16

“Selecting States for Estimation” on page 1-18

“Specifying Initial Guesses and Upper/Lower Bounds” on page 1-19

Creating an Estimation Project

Before beginning the estimation process, you must create an estimation
project and set up the problem by configuring the appropriate parameters,
solvers, and cost functions. Simulink Parameter Estimation provides a
Graphical User Interface (GUI) that makes this setup process quick and easy.
This section describes how to use this GUI to do a complete setup.

To perform the setup:
1 Open the nonlinear idle-speed model of an automotive engine by typing :
engine_idle_speed
at the MATLAB prompt.

The model appears as shown next.
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ﬁengine_idle_speed

File Edit Wiew Simulation Format Tools Help

DSE&| L ER|es 49| r nfin |uom < @S

Idle Speed Engine Model
Copyright () 2002-2004 The MathWworks, Inc.

Monlinearities  Linear Dynamics

gaini

Walve
Waoltage

Idle
Speed

den(z)
Transter Fen

gainz

»{ 1)

den(z) Engine Speed

Transfer Feni

Transport
Delay

gain3

den(z)
3 Transfer Fen2

Click on the Start button in the GUlto
run an estimation.

Ready 100% oded4S
A

2 Open the Control and Estimation Tools Manager GUI by selecting Tools >
Parameter Estimation in the Simulink model window.

The workspace directory tree displays the project name. Estimation tasks
are organized inside the Estimation Task node.

Z]control and Estimation Tools Manager 10l =l
File Wiew Help
D | | |
A\ Wiorkspace ~Task setting
E---_EI Project - engine idle_speed Thle: |
=1 imation Task
Transiert Data Subject: I
Wariables S I
Estimation B
“alidation Company: I
Description: = |
& I i)
Macdlel: engine_idle_speed Open Model Updste Task
=]
JE]|
Select the nodes below to configure and run estimations. A

Control and Estimation Tools Manager GUI

1-10
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Importing Transient Data

To import transient (measured) data for your dynamic system:

1 In the Control and Estimation Tools Manager, select Estimation Task >
Transient Data in the workspace directory tree.

2 Right-click Transient Data and select New to create a New Data node.
Alternatively, you can use the New button to create this node.

L) control and Estimation Tools Manager

=101 x]
File Wiew Help
ok D@ ||
¢ warkspace ~Transient data set:
=W Project - engine_idle_speed Name I FiepeEs I
B - Estimation Task =
ransient: Data
Yariables
Estimation
[g validation
]
Drescription:
=
[
New | Delete | Edit... |
- Mew Data nodz has been added ko Transient Data, ;I
- Mews Data node has been added ko Transient Data, j
-
Transient data sets are skored in this folder. Press Mew' to create a new data set v

3 Select the New Data node in the workspace directory tree.

1-11
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E! Control and Estimation Tools Manager

5 =] 3
File Wiew Help
D | HE|
) viorkspace Input Data Output Data | State Data |
=gl Project - engine_idle_speed ~Assign data to blacks
(=1 Estimation Task - -
= nsient Data Elack Mame | Data I Time | Ts I Weight I Length
P Data _idle_ nyine Speed
Variables Charinel - 1 [ [ [ 1 I -
Estimation
Ea Walidation
Impork. .. Pre-process, .. Flot Data Clear all |
T DI T T T Tee T e T ;I
- Mews Data node has been added to Transient Data,
- Mew Data nodz has been added ko Transient Data,
-
Load projects 4

Import Data into the Control and Estimation Tools Manager

Importing Input Data
To import the model input data:

1 In the New Data node, click the Input Data tab.

2 Right-click the Data cell and select Import to open the Data Import dialog
box. Alternatively, you can use the Import button to open this dialog box.
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3 In the Data Import dialog box,

E! Control and Estimation Tools Manager i =] [

File Wiew Help

D=2 E

. workspace Input Data | Qutput Data | State Data |

=gl Project - engine_idle_speed —Assign data ta blacks

=5 - Estimation Task - -
[7) Transient Data EBlock Mame I Data | Time | Ts I Weight Length
E Mew Data engine_idle_speed BPAY
Wariables Channel - 1 [ I
Estinaton BN
g validation Export...
Pre-process...
Flot Data
Clear Al
Impork. .. Pre-process... Flot Data Clear all |
T Do T T DT e o T oo e D ;I
- Mews Data node has been added to Transient Data,
- Mew Data nodz has been added ko Transient Data,
-
Select the tabbed panels ta configure the transient data set. 4

E! Data Impork |
Import From: I Workspace VI

Yariahle Name I Size | Bvtes | Class |
HH gain3 131 8 double Al
@iodata 7801%2 120016 double
B rmean_speed 1% 2 double
@time 7801x1 60008 double j

+ Assign the Fallowing colurnns ko selected channel(s): |[1:2]

= Assign the Following rows ko selected channel(s): |[1:?501j

Impork | Close I Help I

select iodata from the list of variables.

1-13
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The idle-speed model of an automotive engine contains the measured data
stored in the iodata array. The array contains two columns: the first for
model input data, and the second for model output data.

4 Enter 1 in the Assign the following columns to selected channel(s)
field, and then click Import.

5 Click the Time/T's cell, and select time in the Data Import dialog box.
6 Click Import to import the time vector for the input data.

7 Click Close to close the Data Import dialog box.

Importing Output Data
To import the model output data:

1 In the New Data node, click the Output Data tab.

2 Right-click the Data cell and select Import to open the Data Import dialog
box.

3 Select iodata from the list of variables.

4 Enter 2 in the Assign the following columns to selected channel(s)
field to use the second column of iodata, and then click Import.

5 Click the Time/Ts cell, and select time in the Data Import dialog box.

6 Click Import to import the time vector for the output data.

7 Click Close to close the Data Import dialog box.

Specifying Initial Conditions

By default, the estimation uses initial conditions specified in the Simulink
model. If you want to specify initial conditions other than the defaults, use

the State Data tab. You can open it by selecting Transient Data > New
Data in the workspace directory tree, and then clicking the State Data tab.
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E! Control and Estimation Tools Manager 1ol =l

File Wiew Help

ot O [= 3 [[E

4\ wiorkspace Input Data | Outout Data Stete Data |
EG Project - engine_idle_speed ~Azsign datato state
E|--- Estimation Task
Transient Dsta Block Matne | Samplz Time | Data
-[141] Mewe Dt ine_idle_speed/Transfer Fcn
% “atiables State - 1 | 0 [
Estimation State - 2 | [ |
[ validation ine_idle_speedTransfer Fcn1
State - 1 [ 0 [
State - 2 | 0 \
_idle_speed/Transfer Fch2
State - 1 [ 0 [
State - 2 | 0 \

Import... Clear All |
l |

s L L

Select the tabbed panels to configure the transient data set.

To specify an initial condition of a state:

1 Select the Data cell associated with the state.

2 Enter the initial conditions. In this example, enter -0.2 for State - 1 of
the engine_idle_speed/Transfer Fen. For State - 2, enter 0.

1-15
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) Control and Estimation Tools Manager

File Wiew Help

ot D= 3 [[E

ﬁ Workspace Input Data | Output Data State Data I
E_EI Project - engine_jdle_speed ~Bzsign datato state
[=1-E2) Estimation Task
Transient Deta Elack hame | Sample Time | Data
o] Meswe Dt _idle_speedTransfer Fcn
% Weriables State - 1 0 [ 0.2
Estimation State - 2 | i} ‘ i}
[ validation rengine_jdle_speed/Transfer Fcn1
State - 1 i |
State - 2 | i |
_idle_speed/Transfer Fch2
State -1 [ 0 [
State - 2 | 0 |
Import... Clear All |
Kl I

Select the tabbed panels to configure the transient data set.

N <L I

Selecting Parameters for Estimation

To select parameters for estimation:

1 In the Control and Estimation Tools Manager, select the Variables node in
the workspace directory tree to open the Estimated Parameters pane.

2 In the Estimated Parameters pane, click Add to open the Select
Parameters dialog box.
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x|
Select additional parameters to estimate
Ilarme Size
darmpl 1x1 :l
datnp2 121
BETE] 11
[

Specify expression (e.g., .x, al3), b{21

QK

| Cancel |

Help |

Apply |

By default, the Select Parameters dialog box looks at
all variables in the model workspace and the MATLAB
workspace that are used by the model.

List of parameters

Use your mouse to seked data. To select adjacent
parameters, hold down the Shift key while clicking the
first and last parameter in the selection. To select
nonadjacent parameters, hod down the Ctrl key while
clicking each parameter.

Use the fext field to get the parameters contained in
either a Simulink parameter object, MATLAB array,
structure, or ell array. Nofe that you cannot use
mathematical expressions such as x + 5.

3 Select the last seven parameters: freq1, freq2, freq3, gaini, gain2,
gaingd, and mean_speed, and then click OK.

In general, you can enter parameters, (separated by commas, in the Specify
expression field. The parameters can be stored in one of the following:

® Simulink parameter object

Example: For a Simulink parameter object k, type k.value.

® Structure

Example: For a structure S, type S.fieldname (where fieldname represents
the name of the field that contains the parameter).

e Cell array

Example: Type C{1} to select the first element of the C cell array.

e MATLAB array

Example: Type a(1:2) to select the first column of a 2-by-2 array called a.

1-17
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Note You need not estimate the parameters selected here all at once. You
can first select all the parameters that you are interested in, and then later
decide which ones to estimate in a particular estimation.

Often, it is more practical to estimate a small group of parameters and use the
final estimated values as a starting point for further estimation of parameters
that are trickier. Making these sorts of choices involves experience, intuition,
and a solid understanding of the strengths and limitations of your Simulink
model.

Sometimes models have parameters that are not explicitly defined in the
model itself. For example, a gain k could be defined in the MATLAB
workspace as k=a+b, where a and b are not defined in the model but k is used.
To add these independent parameters to the Select Parameters dialog box, see
“Estimating Independent Parameters” on page 1-57.

Selecting States for Estimation

In general, you choose to estimate only those states that are not already in the
model. To estimate initial conditions (or initial states) if they are not known:

1 In the Control and Estimation Tools Manager, select the Variables node in
the workspace directory tree.

2 Click the Estimated States tab.

3 Click Add to open the Select States dialog box.
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By default, the Select States dialog box looks at all

x
~Select adsdtionsl states to sstimate———————————— states of all blocks in the model.
Elock Marme Length |

engine_idlie_speediTra... 2 il

engine_idle_speediTra... 2 ——r .

engine_idlie_speediTra... 2 I LISt Of states
Use your mouse fo select data. To select adjucent states,
hold down the Shift key while clicking the first and last
state in the selection. To select nonadjacent states, hold
down the Cirl key while clicking each state.

=
Ok | i Cancel | Help | Ay |

4 Examine the available states but do not select any for this example.

Specifying Initial Guesses and Upper/Lower Bounds
After you select parameters for estimation, the Control and Estimation Tools
Manager looks like the following figure.

1-19
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« ) Control and Estimation Tools Manager i =] 5
File Wiew Help
D= HE|
‘Workspace Estimated] Parameters | Estimated S13133|
L) Project - engine_idle_speed | _colacted parameter ~Diefautt setting
61! Estitnation Task
frel B Marne: freg
freq? Walue: 3
free Inifal guess:  [frean
cyaint
Gaing MititriLan: I-Inf
gain3 Paximum: I+Inf
mean_speed
Typical value: Ifreq1
Reterenced by
i ]
engine idle speediTransfer Fon
Delete | |
l I»]
2
[
Select the tab panels to configure your estimation parameters and states. A

For each parameter, use the Default settings pane to specify the following:

Initial guess — The value the estimation uses to start the process.

¢ Minimum — The smallest allowable parameter value. The default is - Inf.

¢ Maximum — The largest allowable parameter value. The default is +Inf.

Typical value — The average order of magnitude. If you expect your

parameter to vary over several orders of magnitude, enter the number
that specified the average order of magnitude you expect. For example, if
your initial guess is 10, but you expect the parameter to vary between

10 and 1000, enter 100 (the average of the order of magnitudes) for the

typical value.
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You use the typical value in two ways:

To scale parameters with radically different orders of magnitude for equal
emphasis during the estimation. For example, try to select the typical
values so that

anticipated value 1

n

typical value
or

initial value 1

n

typical value

To put more of less emphasis on specific parameters. Use a larger typical
value to put more emphasis on a parameter during estimation.
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Setting Up an Estimation Project
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In this section...

“Creating an Estimation Task” on page 1-22

“Adding Data Sets” on page 1-22

“Specifying and Setting Up Parameters” on page 1-24
“Specifying Settings for Estimation” on page 1-25

Creating an Estimation Task

After you import the transient data and select the parameters and any
initial conditions (or states) to estimate, you must create an estimation task
and configure the estimation settings. To create a container that stores the
estimation settings:

1 In the Control and Estimation Tools Manager, right-click Estimation in
the workspace directory tree and select New.

2 Click the New Estimation node.

Adding Data Sets

After you select the New Estimation node, the Data Sets tab appears.
Here you choose the output data from the Simulink model that you want to
use in the estimation.

In this example, select the check box to the right of the New Data data set.
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E! Control and Estimation Tools Manager 1ol =l

File Wiew Help

ot D= & [[E

ﬂ Workspace Data Sets | Parameters' S1&tes| Estimationl

=8 ) Project - engine_idle_speed | oty sets used for estimation———————— ~Output data weight
=-E) Estimation Task
[ Transient Deto | Transient estimation =l BinckName | Length | weight
-[141] M Dt ine_idle_speed/Engine Speed
L variables (i S | Eoieete | Charnel-1 | 75017501 | 1
L Estimation Mew Data | I ||

i E Views
[=-[g alidation

=

Select Al Clear Al |

4 | ]

s L L

Select the tab panels to configure your estimation.

Note If you imported multiple data sets, you can select them for estimation
by selecting the check box to the right of each desired data set. When using
several data sets, you increase the estimation precision. However, you also
increase the number of required simulations: for N parameters and M data
sets, there are M*(2N+1) simulations per iteration.

Then, specify the weight of each output from this model by setting the Weight
column in the Qutput data weights table.

The relative weights are used to place more or less emphasis on specific
output variables. The following are a few guidelines for specifying weights:

¢ Use less weight when an output is noisy.

¢ Use more weight when an output strongly affects parameters.
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® Use more weight when it is more important to accurately match this model
output to the data.

Specifying and Setting Up Parameters

In the New Estimation node in the workspace directory tree, click the
Parameters tab in the Control and Estimation Tools Manager. In this pane,

you select which parameters to estimate and the range of values for the
estimation.

Note When you specify the Minimum and Maximum values for the
parameters here, it does not affect your settings in the Variables node. You

make these choices on a per estimation basis. You can move data to and from
theVariables node into the Estimation node.

E! Control and Estimation Tools Manager o ] [
File WYiew Help

ot D[ W [[E

4 viarkspace Deta Sete Parammeters | States | Estimation|
EG Project - engine idle_speed | e ction parameter
=) Estimation Task
= Tranzient Data Mame alue Estimate Initial Guess Minirrurn haximum Typical Yalue
1] Mevwr Data fregl 3 r fregl -Int +Inf fregl
Yariahles freg2 3 r freg2 -Int +Inf freg2
Estimation fregs 3 [ freqd -Inf +Inf fregd
B New Estimation ] i gain
EE WiEE W~ gain2
[g valication [ +Ini gain3
mean_speed 500 7 500 -Inf +Inf mean_speed
Uz Yalue as Intial Guess Reset to Default Settings Save as Default Settings |
Kl I»
2l
-
Select the tab panels to configure your estimation. v
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You can select the parameters you want to estimate by selecting the check—box
in the Estimate column. Enter initial values for your parameters in the
Initial Guess column. The default values in the Minimum and Maximum
columns are -Inf and +Inf, respectively, but you can select any range you
want.

For this example, set gain1 to 10, gain2 to 100, gain3 to 50, and mean_speed
to 500. Or, use any initial values you like.

If you have good reason to believe a parameter lies within a finite range, it is
usually best not to use the default minimum and maximum values. Often,
there are computational advantages in specifying finite bounds if you can. It
can be very important to specify lower and upper bounds. For example, if a
parameter specifies the weight of a part, be sure to specify 0 as the absolute
lower bound if better knowledge is unavailable.

Specifying Settings for Estimation
In the New Estimation node in the workspace directory tree, click the
Estimation tab to specify the settings for estimation.
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E! Control and Estimation Tools Manager i =] 5

File Wiew Help

ot D= 3 [[E

Select the tab panels to configure your estimation.

{;\ Workspace Data Setsl Parameters' States  Estimation I
E_EI Project - engine_jdle_speed ~Estimation progre:
=-f2 Estimation Task
T ansient Data fteration I Function Court I Cost Function | Step Size Procedure I Estitnation Options... |
o] Mew Dt -]
“ariahles Display Options... |
Estirmation
BB hew Estimation
E Views
[ validation ——
I~ Show Progress views
-
=
[
4 I>]
[
=
&

Before you start, you can click Estimation Options to specify various
algorithms and simulation features. See “Setting Options for Optimization”

on page 1-45for more information.

Display Options
You can specify the display options by clicking Display Options. This opens
the following dialog box.

V¥ Cost function i Step size

V¥ Procedure

Ok Cancel

[V Function count

Help Apply

By default, all boxes are checked. Uncheck any
feature that you don't want to view during the
esfimation process.
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Clearing a check box implies that feature will not appear in the display table
as the estimation progresses.
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Selecting Views for Plotting

1-28

In this section...

“Basic Steps for Creating Plots” on page 1-28
“Types of Plots” on page 1-31

Basic Steps for Creating Plots

Note An estimation must be created before creating views. Otherwise, the
Options table will be empty.

To create plots for viewing the estimation progress, follow the steps below:

1 Right-click the Views node in the Control and Estimation Tools Manager
and select New.

2 In the workspace directory tree, select New View to open the View Setup
pane.
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E! Control and Estimation Tools Manager i =] [

File Wiew Help

o 0| @[T
41 Wiorkspace Wiew Setup I
=gl Project - engine_idle_speed

= - Estimation Task
Transient Data Flok Mumber Flot Type Plat Title:

~Select plot bype:

o[ i4] Mew Data Flot 1 (none
Variables Plot 2 (none
Estimation Plot 3 (none

E@ Meww Estimation Plot 4 (none;

=8 Flot 5 (none;
Ea Flot & (none;

~Ciption:

Estimation
Mew Estimation

Shoy Plats |

Iteration 4 complete
Estimation completed.

s L

Configure dynamic views,

3 In the Select plot types table, select the Plot Type from the drop-down
list. In this example, select Cost function.

1-29



Getting Started

1-30

E! Control and Estimation Tools Manager i =] [

File Wiew Help

ok D= 3 [[E

{\ Wiorkspace Wiew Setup I

=gl Project - engine_idle_speed ~Select plot type:

(=) Estimation Task
= Plak Mumber I Flok Type I Plat Title

=] Transient Data
Mew Data Flot 1 {none) = |
% ariables Flot 2
=gl Estimation Plot 3 Measured and simulated
E@ Mew Estimation Plot 4 Parameter sensitivity
B Ea Views Flot 5 Parameter trajectory
e hlew Yiew Plot & Feesiduals
=-[Ig validation {none)
~Ciption:

Estimation
Mew Estimation

Shoy Plats |

Iteration 4 complete
Estimation completed.

Configure dynamic views,

s L

4 Select Measured and simulated as the Plot Type for Plot 2. This plot
will be used in “Performing Validation” on page 1-38.

5 In the Options area, select the check-box for both Plot 1 and Plot 2.

6 Click Show Plots. This displays an empty cost function plot and a plot
of the measured data. When you run the estimation, the plot updates
automatically.

This figure shows the plot generated by running the estimation, as described
in “Running the Estimation” on page 1-32.
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) New ¥iew - Plot 1 (Measured and simulated) : - |EI|1|
File Edit Wew Insert Tools Desktop ‘Window Help "

DeE&E LK RAN® € 08 01O

easured v, Simulated Responseas
QE0 T T

A plitucize

Engine Spaac

Time [sec)

Types of Plots
You can choose the plot type from the drop-down list under Plot Type.

Various types of plots are available, including
® Cost function — Plot the cost function values.
® Measured and simulated — Plot empirical data against simulated data.

® Parameter sensitivity — Plot the rate of change of the cost function as a
function of the change in the parameter. That is, plot the derivative of the
cost function with respect to the parameter being varied.

® Parameter trajectory — Plot the parameter values as they change.

® Residuals — Plot the error between the experimental data and the
simulated output.
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Running the Estimation

1-32

In the Control and Estimation Tools Manager, select the New Estimation

node and click the Estimation tab.

Click Start to begin the estimation process. At the end of the iterations, the

window should resemble the following:

) control and Estimation Tools Manager

File Wiew Help

=10l

ok 0| J

ﬂ Workspace

Data Sets | Parameters | States Estimstion I
E_EI Project - engine_jdle_speed

~Estimation progre:

=1-F3) Estimation Task
=R im

Estitation Options... |

Display Options ... |

ahzient Data lteration Function Court | Cost Function Step Size Procedure
7] Mews Data i 1 31892e+008 1 x|
Wariables 1 2 28742e+008 [0
Estimation 2 3 2207764008 20
~Cg Mewy Estirmation 3 4 13589e+008 |40
-0 views 4 5 31998e+007 |80
el New i 5 6 SE148e+006  [174 96

-[Cg walidation

I~ Show Rrogress views

Performing transient estimation...

Active experiments: Mew Data

Estimated parameters: gainl, gainZ, gain3, mean_speed
Estimated States for experiment New Dafa: Mone

Optimization terminated: first-order optimality less than
OPTIONS. TolFun, and no negative/zero curvature detected in trust
region model

Kl I+

1 [ET

Iteration & complete
Estimation completed.

Select the tab panels to configure your estimstion.

Al
5
Z

Usually, a lower cost function value indicates a successful estimation,
meaning that the experimental data matches the model simulation with the

estimated parameters.

The Estimation pane displays each iteration of the optimization algorithm.
To see the final values for the parameters, click the Parameters tab.
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E! Control and Estimation Tools Manager

File Wiew Help

ot D= 3 [[E

4 Workspace
E_%I Project - enging_jdle_speed
=i Estimation Task
Transient Data
: 3] Mevw Datar
% Wariables
=L g Estimation
@ Mew Estimation
| E@ Views
el Mew Vieww
- (g validation

Kl I3

Data Sets
~Estirmation parameter

States | Estination |

Mame alue Estimate Initial Guess Minitrirn hizimuim Typical Yalue
frecl 3 [ fragl -Inf +Inf frel
freg2 3 r frag2 -Inf +Inf frec2
fregd 3 r fregd -Inf +Inf fred3
cyaint 124 .56 v 10 -Inf +Inf qairl
a2 2389 v 100 -Inf +Inf gain2
caing 20312 v S0 -Inf +Inf oain3
Fean_speed 73084 v 00 -Inf +Inf Friean_speed

Use Walue s Intial Gusss

Reset to Detaul: Settings

Save a5 Default Settings |

Iteration 5 c:o?plet,e
Estimation completed.

Select the tab panels to configure your estimation.

ol o]

RN

The values of these parameters are also updated in the MATLAB workspace.
If you specify the variable name in the Initial Guess column, you can restart
the estimation from where you left off at the end of a previous estimation.

After the estimation process completes, the cost function minimization plot
appears as shown in the following figure.
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) New ¥iew - Plot 1 (Cost function) : - |EI|1|
File Edit Wew Insert Tools Desktop ‘Window Help % "
DeE&E k| fRa®e € 08 00
: Cost Function
10 T T T T T T T T T
107k __
B
=]
(5]
107k __
10‘ 1 1 1 1 1 1 1 1 1
] 1 2 3 4 3 ] T g &l 10
lterations

If the optimization went well, you should see your cost function converge on a
minimum value. The lower the cost, the more successful is the estimation.
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Model Validation

In this section...
“Basic Steps for Model Validation” on page 1-35

“Example: Validating the Engine Idle Speed Model” on page 1-36
“Loading and Importing the Validation Data” on page 1-37
“Performing Validation” on page 1-38

“Comparing Residuals” on page 1-42

Basic Steps for Model Validation

After you complete estimating the parameters, you can validate your results
against another set of data.

These are the basic steps needed to validate a model using the Control and
Estimation Tools Manager:

1 Add the validation data set to the Transient Data node.

2 Add a new validation task in the Validation node in the workspace
directory tree.

3 Configure the validation settings by selecting the plot types and the
validation data set from the Validation Setup pane.

4 Click Show Plots in the Validation Setup pane and view the results in
the plot window.

5 Compare the validation plots to the corresponding view plots to see if
they match.

The basic difference between the validation and views features is that you
can run validation after the estimation is complete. All views should be set
up before an estimation, and you can watch the views update in real time.
Validations can use other validation data sets for comparison with the model
response. Also, validations appear after you have completed an estimation
and do not update.
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You can validate your data by comparing measured vs. simulated data for
your estimation data and validation data sets. Also, it is often useful to
compare residuals in the same way.

Example: Validating the Engine Idle Speed Model

If you have not run the engine idle speed demo, type:

engine_idle_speed

at the MATLAB prompt and run the estimation. For more information on how
to run the estimation, see “How Simulink Parameter Estimation Works” on
page 1-6. You can double-click the box in the upper-left corner of the model to
import data and populate the required fields in the Control and Estimation

Tools Manager.

E]enginejdlefspeed

File Edit “ew Simulation Format Taools Help

=3

DS 2R (e 4|92y sfin [om |He@sy nEE®

Idle Speed Engine Model
Copyright (0] 2002-2004 The MathWarks, Inc

4>|§| Manlinearities Linear Dynamics

Walve
Woltage

Transport
Delay

oPy=2 den(s)
Fu) gain3

Double click here
o open
Farameter Estim ation
@Ul with preload data

Py =3 den(s)
w3 Transfer Fon2

Click on the Start button in the GUI to
run an estimatian.

Ready

Fu) gaint .
D0Fy =1 den(s) Mean
Speed

e

Idle
Speed

Engine Speed

[100%

|ode4s

engine_idle_speed Simulink Model

Now that the estimation data is loaded, and the estimation task has been
created, the next step is to import validation data into the Control and
Estimation Tools Manager.
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Loading and Importing the Validation Data
To load the validation data, type

load iodataval

at the MATLAB prompt. This loads the data into the MATLAB workspace.
The next step is to import this data into the Control and Estimation Tools

Manager. See “Importing Transient Data” on page 1-11 for information on
importing data, but the quickest way is to follow these steps:

1 Right-click the Transient Data node in the workspace directory tree in
the Control and Estimation Tools Manager and select New.

2 Select New Data (2) from the Transient Data pane.

3 Right-click the New Data (2) node in the workspace directory tree and
select Rename. Change the name of the data to Validation Data.

4 In the Input Data pane, select the Data cell associated with Channel
- 1 and click Import. In the Data Import dialog box, select iodataval
and assign column 1 to the selected channel by entering 1 in the Assign
columns field. Click Import to import the input data.

x|
Irnport From: IWorkspace vI
Yariable Name | Size | Bytes I Class I
@iodataval Tal1x2 120016 double 2]
@mean_speed 11 g double
B tesep TEx1 608 double I
FH texp2 BEx1 528 double |

% Assign the Following columns to selecked channel(s): |1

= Assign the Following rows ko selecked channel(s): I[l 75010

i Import § Close I Help |

5 Select the Time/T's cell and import time using the Data Import dialog box.
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6 Similarly, in the Output Data pane, select Time/T's and import time.

7 In the Output Data pane, select the Data cell associated with Channel
- 1 and click Import. Import the second column of data in iodataval by

selecting it from the list in the Import Data dialog box and entering 2 in the

Assign columns field. Click Import to import the output data.

Your Control and Estimation Tools Manager should resemble this figure.

=) Control and Estimation Tools Manager I ] 4
File Wiew Help
ok D@ ||
Wiorkspace Input Data  Output Data | State Data
Project - engine_jdle_speed ~Azsign datat block:
=l EI! Estitnation Task
- Transient Data e Experimental Data
4] Mew Data Dsta | Titne { T= | Waight | Lergth
- l‘-‘l]_ alidtion Date || |engine_idle_speed/Engine Speed
[ variables Channel - 1 [ ovatavacz) ] timer: 1) [ 1 [ 7so17sm
i=-L Estimation
B hew Estimation
“iews
(g validation
Ittt Pre-process... Plot Drata Clear All |
4 i3]
]
-
4

Select the tabbed panels to configure the transient data set.

Performing Validation

After you import the data, right-click the Validation node and select New.

This creates a New Validation node in the Control and Estimation Tools

Manager.
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) Control and Estimation Tools Manager ;IQIZI
File Wiew Help
ot 0| & [[E
Warkspane ~Walidation:
ojed - ehgine _jdle_speed [o— Properties |
2 estimation Task e alidation =]
=HT Transient Data
111 Mew Data
“alidation Data
“ariables
Estirmation
ey Estirmation
Views
_ J2 Mew View
3 =
e Walication
Drescription:
[
=
e | Delete | Edlit...
Kl I»]
- New View node has been added to Views. ﬂ
[
“alidation node. 4

To perform the validation:

1 Select New Validation in the workspace directory tree to open the

Validation Setup pane.
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E! Control and Estimation Tools Manager

= (a1
File Wiew Help
=R =T
4_:\ Wiorkspace Walidation Setup
=] EI oject - en.gine_idle_speed ~Select plot typ
- ) Estimation Task
nsient Data Plot Murnber Plot Type Plot Title
vy Data Plat 1 Meszured and simulated P
Walidation Data Plot 2 (nane) =
Vatiables Plot 3 (none) ~|
=L &g Estimation
- BB new Estimation || Option
L= Ea YiBwS “alidation deta set: | Validation Data =l
b Mew view
=09 venation Estimation [ Pt
# e Estitnation | v |
Showy Plots |
4 3|
Estimation completed. ;I
Configure validation plots 4

2 Click the Plot Type cell for Plot 1 and select Measured and simulated
from the drop-down menu.

3 In the Options area, select Validation Data in the Validation data set
drop-down list.

4 Click Show Plots to open a plot figure window as shown next.
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) Mew ¥alidation - Plot 1 {Measured and simulated} : - |EI|1|
File Edit Wew Insert Tools Desktop ‘Window Help "

DSed& hRaMe (€08 8O

eazured v, Simulated Responsas
“alickation Data

A plitucize

Engine Spaac

EEQ | |

Time [sec)

Measured Versus Simulated Data Plot for Validation Data

5 Compare this plot with the plot of Measured and simulated data for
the validation data. For more information on how to create this plot, see
“Selecting Views for Plotting” on page 1-28.
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) New ¥iew - Plot 2 (Measured and simulated) : - |EI|1|
-1

File Edit Wew Insert Tools Desktop ‘Window Help
DEed&E haaMme @080
Meazured v=. Simulated Responzes

Iy Dats
950 T T

a00 [ IIM |

850 -

800 -

750 -

Amplitude
Engine Speed

700

800 | i .
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1] al 100 1a0

Time [=ec)

Measured and Simulated Data Views Plot
Transient Data node as a

Comparing Residuals

To look at the residuals, select Residuals as the Plot Type for Plot 2 in the
New Validation pane. In the Options area, select the Plot 2 check box and
click Show Plots. The following figure shows the resulting residuals plot.
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) Mew ¥alidation - Plot Z {Residuals) : - |EI|1|
File Edit Wew Insert Tools Desktop ‘Window Help "
Deds khfaaMe €08 =0
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hlos]
a0
m |-
40 L \
i =
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i}
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—dn
_m |-
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Plot of Residuals Using the Validation Data

Compare the validation data residuals with the original data set residuals
from the Views node in the workspace directory tree. To create the plot of
residuals for the original data set, select the New View node and choose
Residuals as the Plot Type.
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) New ¥iew - Plot 2 (Residuals) : o [ 4]
File Edit Wew Insert Tools Desktop ‘Window Help "
Deds khfaaMe €08 =0
Residuals
Mew Data (2]
hlos] T T
g o
=
] 4
g
. | |
] [=a] pleed 150 O =] L] 180
Time [sec)

Plot of Residuals Using the Test Data
The plot on the left agrees with the plot of the residuals for the validation

data. The right side has no plot because residuals were not calculated for the
validation data during the original estimation process.
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Setting Options for Optimization

In this section...

“Tuning the Results of Optimization” on page 1-45
“Selecting Optimization Methods” on page 1-46
“Selecting Optimization Termination Options” on page 1-47

“Selecting Additional Optimization Options” on page 1-48

“Specifying the Cost Function” on page 1-48

Tuning the Results of Optimization

You can set several options to tune the results of the optimization. These
options include the optimization algorithms and their tolerances.

To set options for optimization:

1 Select the New Estimation node in the workspace directory tree.
2 Click the Estimation tab.

3 Click Estimation Options to open the Options dialog box.
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= ): Options - New Estimation . o ] B |

Sinulation Options  Optimization Options |

~Optimization rmethod

Algarithim: I Monlinear least zguares ll Model size: I Medium scale ll

- Dptimization options

Diff max change: ID.1 Maximum fun evals: |4IZIIZI
Diff min change: |1 e-003 haximum iterations: |1 uln}
Parameter tolerance: ID.IZIIZH Function tolerance: IIZI.D1 |

Display level: I fterationz by l Gradient type: I Basic ll

Cost function: SSE - [T s rabust cost

024 | Cancel | Help | Apply |

4 Click the Optimization Options tab and specify the options, as described
in the following sections:

Selecting Optimization Methods

Both the algorithm and model size define the optimization method. Use the
Optimization method area in the Options dialog box to set algorithm and
the model size.

Optimization method
’7Alg0rithm: I Monlinear least squares LI IModel size: I Medium =scale LI

For the Algorithm parameter, the four options are
® Gradient descent — Uses the Optimization Toolbox function fmincon to
optimize the response signal subject to the constraints

® Nonlinear least squares — Uses a nonlinear least squares optimization
algorithm.

® Pattern search — Uses an advanced pattern search algorithm. This
option requires the Genetic Algorithm and Direct Search Toolbox.
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e Simplex search — Uses the Optimization Toolbox function fminsearch,
which is a direct search method to optimize the response. Simplex search
is most useful for simple problems and is sometimes faster than Function
minimization for models that contain discontinuities.

For Model size, the two options are Large scale and Medium scale. By
default, Model size is set to Large scale. The Large scale methods will
always run faster, if there is some sparsity structure in the Jacobian (or
Hessian) that can be taken advantage of.

For more information on these algorithms, refer to “Medium- and Large-Scale
Algorithms”, “Large-Scale Algorithms”, and “Standard Algorithms” in
Optimization Toolbox documentation.

Selecting Optimization Termination Options
Specify termination options in the Optimization options area.

Optimization options

Diff max change: IU.1 Iaximum fun evals: |4DD
Ditf tnity change: |1 e-005 Iaxirmum iterations: |1 oo
Patameter tolerance: |1 e-006 Function talerance: |1 e-005

Several options define when the optimization terminates:

¢ Diff max change — The maximum allowable change in variables for
finite-difference derivatives. See fmincon in the Optimization Toolbox
documentation for details.

¢ Diff min change — The minimum allowable change in variables for
finite-difference derivatives. See fmincon in the Optimization Toolbox
documentation for details.

¢ Parameter tolerance — Optimization terminates when successive
parameter values change by less than this number.

e Maximum fun evals — The maximum number of cost function
evaluations allowed. The optimization terminates when the number of
function evaluations exceeds this value.
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¢ Maximum iterations — The maximum number of iterations allowed. The
optimization terminates when the number of iterations exceeds this value.

¢ Function tolerance — The optimization terminates when successive

function values are less than this value.

By varying these parameters, you can force the optimization to continue
searching for a solution or to continue searching for a more accurate solution.

Selecting Additional Optimization Options

At the bottom of the Optimization options pane is a group of additional
optimization options.

Display level: I Mone & I Gradient type: I Basic LI

Cost function: =3E i [~ Userobust cost

Additional options for optimization include

¢ Display level — Specifies the form of the output that appears in the
MATLAB command window. The options are Iteration, which displays
information after each iteration, None, which turns off all output, Notify,
which displays output only if the function does not converge, and Final,
which only displays the final output. Refer to the Optimization Toolbox
documentation for more information on what type of iterative output each
algorithm displays.

¢ Gradient type — When using Gradient Descent or Nonlinear least
squares as the Algorithm, Simulink Parameter Estimation calculates
gradients based on finite difference methods. The Refined method offers
a more robust and less noisy gradient calculation method than Basic,
although it does take longer to run optimizations using the Refined
method.

Specifying the Cost Function

The cost function is a function that optimization algorithms attempt to
minimize. You have the following options when selecting a cost function:
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¢ Cost function — The default is SSE (sum of squared errors), which uses a
least-squares approach. You can also use SAE, the sum of absolute errors.

¢ Use robust cost — Makes the optimizer use a robust cost function instead
of the default least-squares cost. This is useful if the experimental data has
many outliers, or if your data is noisy.
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In this section...

“Specifying Simulation Options” on page 1-50
“Selecting Simulation Time” on page 1-51

“Selecting Solvers” on page 1-52

Specifying Simulation Options

To optimize the response signals of a model, Simulink Parameter Estimation
runs simulations of the model.

To set options for simulation:

1 Select the New Estimation node in the workspace directory tree.

2 Click the Estimation tab.

3 Click Estimation Options to open the Options dialog box.

«): Options - New Estimation . =)=l

Simulation Cptions | Optirization Cptions |

—Sitnulation time

Start time: Iau‘[o Stoptime:  |auto

—Solver options

Type: IVariabIe-sﬂep LI Salver: Inde45 [Darrrand-Prince) LI

Iaximum step size:  |auto Relative tolerance: ID.DD1
Minirmutn step size:  |auto Absolute tolerance: |1 e-003

Initial step size: aLto Zero crossing contral: | On B

Ok | Cancel | Help | Apply |
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4 Click the Simulation Options tab and specify the options, as described in
the following sections.

Selecting Simulation Time

Simulation time

Start tirne: Iautc- Stop tine: Iaut-:-

By default, Start time and Stop time are automatically computed based on
the start and stop times specified in the Simulink model.

To set alternative start and stop times for the optimization, enter them under
Simulation time. This action overwrites the simulation start and stop times
specified in the Simulink model.

Simulation Time for Data Sets with Different Time Lengths
Simulink Parameter Estimation can handle simulation of models containing
empirical data sets of different time lengths. You can use experimental data
sets for estimation that contain I/O samples collected at different time points.

The following example shows a single-input, two-output model for which
you want to estimate the parameters.

y1(?)

u(t)
y2(t)

The model uses two output data sets containing transient data samples for
parameter estimation:

¢ Qutput yI1(¢) at time points 1 = {t%,t%,....t,ll}.

e Qutput y2(¢) at time points #2 = {t%,t%, ..... t;%@}

Simulink Parameter Estimation computes the simulation time ¢ as:
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This new set ranges from ¢min to tmax. The values ¢tmin and ¢tmax represent
the minimum and maximum time points in ¢ respectively.

When you run the estimation, the model is simulated over the time range ¢.
Simulink extracts the simulated data for each output based on the following
criteria:

e Start time — Typically, the start time in the Simulink model is set to 0.
For a nonzero start time, the simulated data corresponding to time points

before tll for y1(t) and t12 for y2(t) are discarded.
* Stop time — If the stop time ¢y, 2¢y,x, the simulated data

corresponding to time points in ¢1 are extracted for y1(¢). Similarly, the
simulated data for time points in ¢2 are extracted for y2(¢).

If the stop time Zy,, <?¢pax, the data spanning time points > ¢,
discarded for both yI(¢) and y2(¢).

top are

Selecting Solvers

Solver options

Type: I Yariable-step LI Salver: I odeds (Dormand-Prince) LI
Maxirmum step size:  |auto Relative tolerance: ID ot

Minimuin step size:  |auto Absolute tolerance: ]

Initial step size: Lo fero crossing contral: | On &

When running the simulation, Simulink solves the dynamic system using
one of several solvers. You can specify several solver options using the
Solver options area in the Options dialog box. The Type of solver can be
variable-step or fixed-step. Variable-step solvers keep the error within
specified tolerances by adjusting the step-size the solver uses. Fixed-step
solvers use a constant step-size. When your model’s states are likely to vary
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rapidly, a variable-step solver is often faster. See the Simulink documentation
for information about solvers.

Variable-Step Solvers
When you select Variable-step as the solver Type, you can choose any of

the following as the Solver:

® discrete (no continuous states)
® ode45 (Dormand-Prince)

® 0de23 (Bogacki-Shampine)

® ode113 (Adams)

® odel15s (stiff/NDF)

® 0de23s (stiff/Mod. Rosenbrock)

® 0de23t (Mod. stiff/Trapezoidal)
e ode23tb (stiff/TR-BDF2)

Variable-Step Solver Options

When you select Variable-step as the solver Type, you can also set several
other parameters that affect the step-size of the simulation:

¢ Maximum step size — The largest step-size Simulink can use during a
simulation.

® Minimum step size — The smallest step-size Simulink can use during a
simulation.

¢ Initial step size — The step-size Simulink uses to begin the simulation.

* Relative tolerance — The largest allowable relative error at any step in
the simulation.

® Absolute tolerance — The largest allowable absolute error at any step in
the simulation.

e Zero crossing control — Set to on for the solver to compute exactly
where the signal crosses the x-axis. This is useful when using functions

1-53



1 Getting Started

1-54

that are nonsmooth and the output depends on when a signal crosses the
x-axis, such as absolute values.

By default, Simulink automatically chooses values for these options. To
choose your own values, enter them in the appropriate fields.

Fixed-Step Solvers
When you select Fixed-step as the solver Type, you can choose any of the

following as the Solver:

® discrete (no continuous states)

® ode5 (Dormand-Prince)

® ode4 (Runge-Kutta)

® ode3 (Bogacki-Shanpine)

® ode2 (Heun)

® odel (Euler)

When you select Fixed-step as the solver Type, you can also set Fixed step

size, which determines the step-size the solver uses during the simulation.
By default, Simulink automatically chooses a value for this option.
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Accelerating the Estimation

In this section...

“About Accelerating Estimation” on page 1-55

“Limitations” on page 1-55

“Setting the Accelerator Mode for Parameter Estimation” on page 1-55

About Accelerating Estimation

You can accelerate the parameter estimation computations by changing the
simulation mode of your Simulink model. Simulink Parameter Estimation
supports Normal and Accelerator simulation modes. For more information
about these modes, see in the Simulink documentation.

The default simulation mode is Normal. In this mode, Simulink uses
interpreted code, rather than compiled C code during simulations.

In the Accelerator mode, Simulink Parameter Estimation runs simulations
during estimation with compiled C code. Using compiled C code speeds up the
simulations and reduces the time to estimate parameters.

Limitations

You cannot use the Accelerator mode if your model contains algebraic loops.
If the model contains MATLAB function blocks, you must either remove them
or replace them with Fen blocks.

Setting the Accelerator Mode for Parameter
Estimation

To set the simulation mode to Accelerator, open the Simulink model window
and perform one of the following actions:

e Select Simulation > Accelerator.

® Choose Accelerator from the drop-down list as shown in the next figure.
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File Edit Wiew Simulation Format Tools Help

E!engine_idle_speed
=

DedS| 2R |E= 4 =] =

I Mormal

Mol

Idle Speed Engin

13t "
Fiapid &ccelerator k
External

Copyright (o) 2002-2004 The

Manlinearities  Linear Dynamics

run an estimation.

Ready

Transfer Fen2

Click on the Start button in the GUIl to

Valve faimt 1dle
Vaoltage den(z) Speed
Transfer Fen
ain2
gain2 o S
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Delay
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S |
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Tip To obtain the maximum performance from the Accelerator mode, close

all Scope blocks in your model.
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Estimating Independent Parameters

In this section...

“Basic Steps for Estimating Independent Parameters” on page 1-57

“Example: Estimating Independent Parameters” on page 1-57

Basic Steps for Estimating Independent Parameters

Sometimes parameters in your model depend on independent parameters that
do not appear in the model. The following steps give an overview of how to
use Simulink Parameter Estimation to estimate independent parameters:

1 Add the independent parameters to the model workspace (along with
initial values).

2 Define a Simulation Start function that runs before each simulation of the
model. This Simulation Start function defines the relationship between the
dependent parameters in the model and the independent parameters in
the model workspace.

3 The independent parameters now appear in the Select Parameters dialog
box. Add these parameters to the list of parameters to be estimated.

Caution Avoid adding independent parameters together with their
corresponding dependent parameters to the lists of parameters to be
estimated. Otherwise the estimation could give incorrect results. For
example, when a parameter x depends on the parameters a and b, avoid
adding all three parameters to the list.

Example: Estimating Independent Parameters

Assume that the parameter Kint in the model srotut1 is related to the
parameters x and y according to the relationship Kint=x+y. Also assume that
the initial values of x and y are 1 and -0.7 respectively. To estimate x and y
instead of Kint, first define these parameters in the model workspace. To

do this:
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1 At the MATLAB prompt, type
srotut1
This opens the srotut1 model window.

2 Select View > Model Explorer from the srotut1 window to open the
Model Explorer window.

3 In the Model Hierarchy tree, select the srotutl > Model Workspace
node.

& Model Explorer

=10l x]
File Edit Wiew Tools Add Help
D@ smmx[HHERHF 00 Do/ 45| Anm A
JJ Search: Ib_l,l Block Type LI Type: IGain LI Search ‘
Model Hierarchy Contents of: Model Workspace Model Workspace
=B8] Simulink oot = | il e
1 Base Workspace Data source:l MOL-File |
--Eengine_idle_speed
E--Esrotut‘l Import from MAT-FiIel Export to M&T-File | | Clear Workspacel
ﬁ Model Warkspace
---%Eonfiguration [&ctive)

tadel arguments [far referencing this model]:
@ Code for srotut]

@ Advice for zrotut]
E----ﬁ.lsignal Constraint

| |_>| Conterts |SearchF|esuIts | Rewvert | Help | Lpply

4 Select Add > MATLAB Variable to add a new variable to the model

workspace. A new variable with a default name Var appears in the
Contents of: Model Workspace pane.

5 Double-click Var to make it editable and change the variable name to x.
Edit the initial Value to 1.

6 Repeat steps 4 and 5 to add a variable y with an initial value of -0.7. The
Model Explorer window should resemble the following figure.
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& Model Explorer

(ol x]
File Edit View Tools Add Help
D[ smax BHEWHF F00 D040 | Aarm= A
H Search: |by Block Type ;I Type: |Gain LI Search |
Madel Hierarchy Contents of: Model Woarkspace® Model Workspace
E--@S\mu\ink Faat I Mame I\p’a\ual DataType wokspceddl
- i Base Workspace =l 07 Data soulca:l MOL-File |
-ﬂenglne_ldle_speed ma j
=k Esrotuﬂ * Imnport fram MAT-Fi\el Expart ta MAT-File | Clear Workspacel
- H Model Workspace®

b é%};Cnnfiguration [Active]
£k Code for srotutt

i B Advice for srotut]
..ES\gnal Constraint

tadel arguments [for referencing this model):

< | 2]

1 |_}| Canterts ISearchF!esuIts I Feyvert | Help | Lpply

SN

7 To add the Simulation Start function defining the relationship between
Kint and the independent parameters x and y, select File > Model
Properties in the Simulink model for srotut1.

8 In the Model Properties window, click the Callbacks tab.

9 To enter a Simulation start function in StartFen*, type the name of a new
M-file, for example, srotuti_start.

10 Create a new M-file with this name. The contents of the M-file should
define the relationship between the parameters in the model and the

parameters in the workspace. For this example, the M-file should resemble
the following:

wks = get_param(gcs, 'ModelWorkspace')
X = wks.evalin('x"')

y = wks.evalin('y")

Kint = x+y;

Note You must first use the get_param function to get the variables x and
y from the model workspace before you can use them to define Kint.
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11 When you select parameters for estimation in the Variables node, x and y
appear in the Select Parameters dialog box.

E Select Parameters |

—Select additional parameters to estimate

Mame Size:
kint 1x1 x|
i 1x1
k4 1x1
y 1=1
zeta 1x1

=

Specify expression (2.g., 5.x, a(3), b{2th

o |[[Grca| e | o |

12 Follow the workflow described in “Setting Up an Estimation Project” on
page 1-22 to estimate the parameters.
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2 Estimating Initial Conditions

Why Estimate Initial Conditions?

Often, sets of measured data are collected at various times and under different
initial conditions. When you estimate model parameters using one data

set and subsequently run another estimation with a second data set, your
parameter values may not match. Given that Simulink Parameter Estimation
attempts to find constant values for parameters, this is clearly a problem.

Fortunately, Simulink Parameter Estimation has features that make this
task simpler. The Control and Estimation Tools Manager has an Estimated
States pane that lists the states available for initial condition estimation. So,
you can estimate initial conditions using procedures that are similar to those
you use to estimate parameters. You can then use these initial condition
estimates as a basis for estimating parameters for your Simulink model.

This chapter focuses on the steps required to estimate initial conditions, and
then estimate the parameters from these initial conditions.



Estimating Initial Conditions for Blocks with External Initial Conditions

Estimating Initial Conditions for Blocks with External
Initial Conditions

When an integrator block uses an initial-condition port, which you specify by
an IC block feeding into the integrator block, you cannot estimate the initial
conditions (ICs) of the integrator using Simulink Parameter Estimation.
This is because external ICs have priority over the ICs of a specific block to
maintain the integrity of the model.

To tune the ICs of an integrator block with external ICs, you must modify the
model to make the external signal into a tunable parameter. For example, you
can set the IC block that feeds into the integrator to be a tunable variable
that Simulink Parameter Estimation can estimate.
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Example: Mass-Spring-Damper System

In this section...

“Loading the Example” on page 2-4
“Model Parameters” on page 2-5
“Setting Up the Estimation Project” on page 2-6

“Importing Transient Data and Selecting Parameters for Estimation” on
page 2-7

“Selecting Parameters and Initial Conditions for Estimation” on page 2-8
“Creating the Estimation Task” on page 2-10

“Running the Estimation and Viewing Results” on page 2-11

Loading the Example

To open the Simulink model of a mass-spring-damper system and two sets of
model data with differing initial conditions, type:

msd_system
at the MATLAB prompt.

The figure shown next is a model of a mass-spring-damper system.




Example: Mass-Spring-Damper System

E!msd_system ;IEIII

File Edit VYiew Simulation Format Tools Help
DeE&E| 2B r nf [Noma — ~]| O b B & |

Mass-Spring-Damper System
Copyright (o] 2002-2004 The MathiWorks, Inc.

Velwoity Posi‘tbnn

T =
= o=

=01

Positions

[tesep yespl]

Experirzntal

Fosition Data 1

[resepE yesnpE]

Experirmantal

Position Data 2

u]
Double click ham fmbH
0 open the Click on the Start button in the SUI hiode!
Pamrmeter Estimation 10 MIn an estimation.

Pammetes hizs=4S pring/Carmper

GUI with prelbaded data
o model wotspace) Walues

Ready [1002 [ [ |ode3 v

You can run the demo from Simulink > Simulink Parameter Estimation
on the Demo pane of the Help browser.

This example goes beyond what is included in the Simulink Parameter
Estimation demo that uses this model by providing in-depth discussion of
each task.

Model Parameters

The Simulink msd_system model’s output is the displacement (or position)

of the mass in a mass-spring-damper system, subject to a constant force F,
and an initial condition, x0, for the mass displacement. x0 is indicated by the
initial condition of the Position integrator block. Click the Start Simulation
button *» to run the simulation once and observe the response of the model to
two sets of parameter values.
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) Positions

Magenta and cyan lines are
emperical resporses for data
with different initial conditions.
Yellow line is the response of
the model fo a constant force.

The model parameters of interest are the mass, m, the viscous damping, b,

and the spring constant, k. For more information about physical modeling

of mass-spring-damper systems, see any elementary book on mathematical
modeling or on automatic control systems.

For the estimation of the model parameters m, b, and k, this model uses two
sets of experimental data. These data sets were obtained using two different
initial positions, x0=0.1 and x0=0. 3, and also contain additive noise. A plot
of these data sets is shown in the figure above (top curves), along with the
simulated response (bottom curve) of the Simulink model msd_system for
x0=-0.1 and a nominal set of parameter values, m=8, k=500, and b=100.

Setting Up the Estimation Project

To set up the estimation of initial conditions and then transient state space
data, select Tools > Parameter Estimation in the msd_system model
window.



Example: Mass-Spring-Damper System

«J: Control and Estimation Tools Manager =101 x|
File wiew Help

s =2 = )

Workspace rTask Setting:
E'I—ijec:t - msd_system Title: I
[=—Operating Poirts
\—Defaull Operating Point Subject: I
= . o Ta
[7}] Transient Data e I
i CommpEny: I
Descrigtion: ;I
[~
I Mocel: fris_gystern Open Madsl Undste Task |
4 3

E
[
4

Select the nodes below to configure and run estimstions .

Importing Transient Data and Selecting Parameters
for Estimation

The process for importing transient data and selecting parameters for
estimation is discussed in “Importing Transient Data” on page 1-11 and
“Selecting Parameters for Estimation” on page 1-16.

1 In the Control and Estimation Tools Manager, select Estimation Task >
Transient Data in the workspace directory tree.

2 Right-click Transient Data and select New to add a new data set.

3 Right-click the New Data node in the workspace directory tree and select
Edit to open the Input Data, Output Data, and State Data panes.

4 In the Output Data pane, click Import and add yexp1 to the Data column
and texp1 to the Time/Ts column of the msd_system/Position state.
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5 If you like, right-click New Data in the workspace directory tree and

rename it to Data set #1.

6 Repeat steps 1 to 5 to add a second data set, yexp2 and texp2, and rename

it to Data set #2.

Your Control and Estimation Tools Manager should resemble this figure:

« ) Control and Estimation Tools Manager

=10l x]
File wiew Help
s = = W)
Workspace Input Data  Cutput Data | State Data |
OJBd - isd_systemn ~&zsigh Data to Elock
=] Estimation Task
i Expetimental Data
-5 Transient Data Block Name b
zet #1 Data Tirme | Ts I Wizight Length
Data set #2 msd_system/Position
N Wariables Charinel - 1 [ vexpl (11 tewpr 10 [ 1 TERE
._ Estimation msd_system/Velocity
3
@ */aldation Charnel - 1 I 1 -
Irnport... Pre-process... Clest Al |
~ New Data node has been added to Transient Data. i’
[
Select the tabbed panels to configure the transient data set. A

Selecting Parameters and Initial Conditions for

Estimation

First, select the parameters you want to estimate for the Simulink msd_system

model. In this case, select b, k, and m. To do this:

1 Select the Variables node in the workspace directory tree of the Control

and Estimation Tools Manager.

2 Click the Estimation Parameters tab.
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3 Click Add to open the Select Parameters dialog box.
4 Select the parameters b, k, and m, and then click OK.

5 Do the same with the Estimation States pane, and select
msd_system/Position from the Select States dialog box.

« ) Select States x|
Select additional states to estimat

i Select states with inifial
mdl_systempelocty conditions that you want to
estimate.

Hold down Shift and use your
mouse fo select groups of
adjacent states. Hold down Ctrl
and use your mouse to select
nonadjacent states.

=

Ok Canicel Hel | Apply |
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Your Control and Estimation Tools Manager should look like this.

«J: Control and Estimation Tools Manager =101 x|

File wiew Help

s =2 = )

Workspace Estitnated Parameters Estitnated States
G Project - msd_system Selected stat

Default setting

Elock name:  Posttion

Data set #1 Ve J-0
a_exp2
Imitial guess: I-D.1
: on Minitum: -inf
L@ validstion !
aximurm: |+In1

Typical walue; I—El.1

Satnple tirme: IEI

Full narme:

msd_system/Position =

L L

Configure here your parameters and states to estimate.

Creating the Estimation Task

To create the New Estimation task in the Control and Estimation Tools
Manager, right-click the Estimation node in the workspace directory tree
and select Add. While the initial velocity is also a state of the model, assume
(for simplicity) that it is known to be 0. The estimation task for this case

is Estim (with IC).

In the Data Sets, Parameters, and States panes for the New Estimation
task, select all the check boxes in each table. Be sure to select Position for
both data sets in the States pane to estimate the initial condition for the
spring’s position.

The initial position estimates for the two data sets are known to differ, but set
the initial state guesses for both data sets to -0.1.
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«): Control and Estimation Tools Manager ;Iglll

File Wiew Help

= = = )

‘Wirkspace Estimated Parameters Estimated States

~Selected state: Default setting:

Elock name:  Position

Walue: I-D.1
Initial guess: I-D.1
Mdiniraun: I-Inf
hdadirmuim: |+Inf

Typical value: I-D.1

Sarmple time: ID

Full name:

med_systernPosition

Add.. Delete |

Configure here your parameters and states to estimate.

QLAY

Running the Estimation and Viewing Results

Click Start in the Estimation pane to run the estimation. As the estimation
proceeds, the most current estimation of position response (yellow curve)
updates itself in the Scope. The curve appears to toggle between the two
experimental data sets, since the estimator uses the two sets successively to
update the estimates of the parameter values. The estimator converges to
the correct parameter values, within the scope of experimental noise and
optimization options settings, as indicated by the closeness of the estimated
response (yellow) to the experimental data (magenta). Good state estimates
for the initial position are also obtained, as can be observed from the States
tab of Estim(with IC) estimation task.
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EEEEE EEIEE

The simulated data is a good maich fo
the measured (experimental) data.

The estimation of initial states is important for obtaining the correct estimates
of the model parameters. Why not set the initial states (x0 in this case) as
parameters as well? The reason is that the initial states are not fixed physical
properties of the system. For different experimental data or operating
conditions, these states need not be unique. In this example, two data sets,
with distinct initial positions, were used together for a single estimation of
model parameters. While the estimates of the model parameters are unique,
the initial state (position) is different, and is estimated individually for each
data set.
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3 Preprocessing Data

Why Preprocess Data?

When dealing with empirical data, it is often useful to remove outliers,
smooth, detrend, or otherwise treat the data to make it more tractable for
analysis and estimation purposes. Simulink Parameter Estimation provides
features that perform the following tasks:

¢ Exclusion — Eliminate outliers, represent them as NaNs, or use
interpolation.

¢ Detrending — Remove mean values or a straight line trend.

¢ Filter — Smooth data using a first-order filter, an arbitrary transfer
function, or an ideal filter.

You can overwrite the existing data with the preprocessed data, or store it
in a new file.



Data Preprocessing Tool

Data Preprocessing Tool

Simulink Parameter Estimation provides a GUI for data preprocessing, which
is the Data Preprocessing Tool. To open it:

1 Open the Control and Estimation Tools Manager.

2 Select the Transient Data node in the workspace directory tree, and then

choose the data you want to modify in the Input Data, or Output Data
pane. This enables the Pre-process button.

E! Control and Estimation Tools Manager

= [=[ 3]
File Wiew Help
ot D= 3 [[E

Input Data | Qutput Data | State Data |
~Assign data to blocks

I Elock Mame I Data | Time | Ts I ‘Weight I Length

engine_idle_speed BPAY
iodatal:, 1) ‘ time |

1 [ 75017501
Estimation
@ Mew Estimation
E Views

m Walidation

Import. .,

Flok Data Clear all |

Show or hide the output area

s L

3 Click the Pre-process button to open the Data Preprocessing Tool.
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3-4
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In this chapter, the sample data set is the same as used in the
engine_idle speed Simulink model. See “How Simulink Parameter
Estimation Works” on page 1-6 for an overview of creating estimation projects
and adding data sets.

With the Data Preprocessing Tool, you can

Exclude data by selecting it with your mouse.

Exclude data graphically by selecting regions on a plot.

Exclude data by rules, such as upper or lower bounds.
Detrend data.
Filter data.




Excluding Data

Excluding Data

In this section...

“Techniques for Excluding Data in the Data Preprocessing Tool” on page 3-5
“Selecting Data for Exclusion from the Data Editing Table” on page 3-5
“Selecting Data for Exclusion from a Plot of the Data” on page 3-8

“Selecting Data for Exclusion by a Rule” on page 3-11

Techniques for Excluding Data in the Data
Preprocessing Tool

You can use the Data Preprocessing Tool to select a portion of the data to be
excluded from the estimation process. You can choose one of the following
techniques:

® Selecting data from the Data Editing Table.

® Selecting data from a plot of the Data.

® Specifying a Rule.

You accomplish the first two manually, and for the last you specify a rule.
When you exclude data using manual selection, the excluded data is shown
as red. When you exclude data using a rule, the background color of the cell

becomes gray. When a portion of the data is excluded both manually and by a
rule, the data is red, and the background is gray.

Note Changes in data are visible everywhere. When you use the Data
Editing table, you can view the results in the data plot.

Selecting Data for Exclusion from the Data Editing
Table

The Data Editing table lists both the raw data set and the modified data
that you create.
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Diata Editing

Ry cata

Modified data

Time [zecs)

iodatat: 1] |

21 680

-0.472

21.700

-0.513

21.720

21.740

21,760

21.780

21.500

21,820

21,540

21,860

21,880

21,800

21.820

21.840

21,860

-0.931

21,880

|-048

- Excluded by a rule
Manually excluded

[~
Exclude Graphically }

Use your mouse to sekedt groups of
cells for exclusion. Selected celks
become blue. Right-click and select
Exclude. The background becomes
white, but the numbers are now red.

Click this button 1o view the data
graphically.

There are two tabs in the Data Editing pane: Raw data and Modified
data. The Raw Data pane shows the working copy of the data. For example,
if you exclude rows of data in the Raw data pane, the corresponding rows
of numbers become red in this table. By default the Modified data pane
represents the rows you removed by inserting NaNs.



Excluding Data

~Data Editing
Raw data  Modified data
Titne (ecs) iodatal: 1)*
&.760 0.8739 N
&.750 0.976
5500 0472 =
5520 0.9639
5540 Mal
& 380 [
330 [
&.a00 [
5320 [y
6.940 Mah
&850 [
GEEN] [
8.0 hihl
8.20 [
.40 [
960 ] ﬂ
- Excluded by arule
M anually excluded

By default, data that you excluded from the
Raw Data table is represented by Nals in
the Modified Data tabk. If you choose to
interpolate or remove missing data, the
results of that action are shown in the
Modified Datu fable.

In the Modified data pane, you can choose to remove the excluded data
completely or interpolate it. See “Miscellaneous Data Handling” on page

3-16 for more information.

After you select data for exclusion, you can view it graphically by clicking
Exclude Graphically.
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+) Select Points for Preprocessing Rule

~=1alx]

— Specify Axes

X Time

'S I indatal: 17 - i

—— Selection

Selecting points:
# Excludes them

€ Inzludes them

Include Al |
Exclude Al |

Close |

Input Data

# Manually excluded

&0 100
Time (sec)

Cutput Data

150

O Exeluded by rule

1000

3000 4000 5000

Pasition

GOOO TG00

The dafa
exduded by
hand is marked
in red.

As you make changes in the Data Editing pane, they immediately appear in
the Select Points for Preprocessing Rule window, and vice versa.

Selecting Data for Exclusion from a Plot of the Data

You can exclude data graphically. Click Exclude Graphically to open the
Select Points for Preprocessing Rule window.



Excluding Data

+) Select Points for Preprocessing Rule - |E||5|

Input Data

Specify Axes

X Time

'S I indatal: 10 - i

2 L .
1} &0 100 150

— Selection ———— Time (sec)
# Manually excluded O Excluded by rule
Selecting points:
¥ Excludes them Output Data

€ Inzludes them

Include Al |
4]
Exclude Al |
0&1

1000 2000 23000 4000 5000 G000 FOO0

Clase | Pasition

The way you exclude data is similar to the way you select a region for
zooming: place your cursor in the Input Data plot and drag the mouse to
draw a region of exclusion.

This figure shows an example of resulting data exclusion in the input data.
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+) Select Points for Preprocessing Rule

~1alx]

_ Specify Axes

X Time

'S I indatal: 10 - i

Input Data

— Selection

Selecting points:
# Excludes them

€ Inzludes them

&0

# Manually excluded

100
Time (sec)

150

O Excluded by rule

Cutput Data

T T

The excluded area
is red in the Input
Data plot.

By default, In the

Output Data plot,
the excluded input

data produces a
blank area.

Include Al |
Exciude Al |

1000 2000 3000 4000 H000 G000 FOo0
Pasition

Close |

In the Output Data plot, the excluded input data produces a blank area by
default. This corresponds to the NaNs that now represent excluded data. If
you choose to interpolate or remove the excluded data, the output data shows
the interpolated points.

When you make changes in the Select Points for Preprocessing Rule window,
they immediately appear in the Data Editing pane, and vice versa.

Selection Pane

By default, any box that you draw with your mouse selects data for exclusion,
but you can toggle between exclusion and inclusion using the Selection pane
on the left side of the Select Points for Preprocessing Rule window.



Excluding Data

— Selection
Selecting points:
Use these radio buttons fo toggle between
inc|ut|'|ng and exduding selected data.

{*' Excludes them_—______

" Includes them

Use these buttons to include or exclude all

Include All | T — Ihe dﬂfﬂ.
Exclude Al |

Selecting Data for Exclusion by a Rule

A more precise way to exclude data is to use mathematical rules. The
Exclusion Rules pane in the Data Preprocessing Tool allows you to enter
customized rules for excluding data.

Excluzion Rules | DetrendJ'FiIteringl

Exclude X: |<= 'I I Exclude X;: |>= VI I
Exclude Y |<= VI I Exclude ¥ |>= vi I

™ Outliers

Whinclose length: I2D
Confidence limits (%) IQS

[~ MATLAB EXpression Ios(x)>1
[ Flatiines  Window: |22

These are the rules you can use to exclude data:

e “Upper and Lower Bounds” on page 3-12
e “Qutliers” on page 3-12
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o “MATLAB Expressions” on page 3-12
¢ “Flatlines” on page 3-12

Upper and Lower Bounds

Select the Bounds check box to activate upper and lower bound exclusion.
Enter numbers in the Exclude X and Exclude Y fields for upper and lower
bound exclusion. By default, the exclusion rule is to include the boundary
values, but you can use the menu to exclude the boundaries as well.

Ouitliers

Select the Outliers check box to activate outlier exclusion. You can set the
Window length to any positive integer, and use confidence limits from 0 to
100%. The window length specifies the number of data points used when
calculating outliers.

MATLAB Expressions

Use the MATLAB expression field to enter any mathematical expression
using MATLAB code. Use x as the variable name in your expression for the
data being tested.

Flatlines

If you have areas of your data set where the data is constant, providing no
new information, then you can choose to exclude those data points as flatlines.
The Window length field sets the minimum number of constant data points
required to define the area as a flatline.
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Example of Rule Exclusion
This figure shows data with a region of the x-axis excluded.

<) Select Points for Preprocessing Rule _ 0] x|

Input Data
2 T T T :

The region of

 Specify axes | ] 7 data excluded
- ] by rule is shaded
W Time A | gl‘tly

W I iodatal: 17 vi

(=]

50 0 &0 100 180 200
— Selection ————— Time (zaa)

= Manually excluded O Excluded by rule

Selecting points:
*' Excludes them

" Includes them

Inziude Al |
ol

Exclude Al |
o5l

1 1 N
1000 2000 3000

1 L L L
4000 G000 G000 FOO0O0
Close |
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Detrending and Filtering

In this section...

“Detrending and Filtering Data in the Data Preprocessing Tool” on page
3-14

“Detrending” on page 3-14

“Filtering” on page 3-15

Detrending and Filtering Data in the Data

Preprocessing Tool
You can both detrend and filter data using the Detrend/Filtering pane in
the Data Preprocessing Tool.

Exclusion Rules DetrendiFitering |

[ Detrending = Constant

| Straight Line

[~ Fittering ~ Select fitter type IFirstUrder 'l

First arcier filter with time constant |1 il

Detrending

To detrend, select the Detrending check box. You can choose constant or
straight line detrending. Constant detrending removes the mean of the data
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to create zero-mean data. Straight line detrending finds linear trends (in the
least-squares sense) and then removes them.

Filtering

You have these choices for filtering your data:

® First order — A filter of the type

s+1
where 7 is the time constant that you specify in the associated field.

® Transfer function — A filter of the type

aps” +a, 15"+, +ag

b,s™ +b, 15"+, +b

where you specify the coefficients as vectors in the associated A
coefficients and B coefficients fields.

® Ideal — An idealized (noncausal) filter, either stop or pass band. Specify
either filter as a two-element vector in the Range (Hz) field. These filters
are ideal in the sense that there is no finite rolloff or ripple; the ends of the
ranges are perfectly horizontal in the frequency domain.
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Miscellaneous Data Handling

In this section...

“Handling Missing Data” on page 3-16
“Loading Data and Saving Modified Data Sets” on page 3-16

Handling Missing Data

You can use the Missing Data Handling pane at the bottom of the Data
Preprocessing Tool to remove rows of data, or to interpolate between points
to fill in missing data.

Missing Data Harndling

[ Remove rows where |2l v | datais excluded o miEEing r Interpolate mizsing values using interpolstion method | zah i

Removing Rows

If you select the Remove rows where check box, the affected rows are
removed from the Modified data pane. If you have multiple columns of
data, select all to remove rows in which all the data is excluded. Select any
to remove any excluded cell. In the case of one-column data, any and all
are equivalent.

Interpolation

You have two choices if you want to interpolate data: zero-order hold (zoh)
and linear interpolation (Linear). Select the Interpolate missing values
using interpolation method check box and choose which method you want
from the list. The results appear in the Modified data pane.

Loading Data and Saving Modified Data Sets

At the top of the Data Preprocessing Tool, there is a region for selecting data
sets for preprocessing, and for saving modified data sets.

ModifydatafmmIengine_idle_speed... 'l Witrite resutts to ™ existing datazet INew Dataﬂ G hew dataset IDa‘tasetB
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When you have multiple data sets, select the one you want to preprocess from
the Modify data from list.

To overwrite an existing data set, select the existing dataset option and
choose the data set you want to overwrite. If you want to save the data
set under a new name, select new dataset and type the new name in the
associated field.
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Managing Multiple Projects

Multiple Projects and Tasks (p. 4-2)

Saving Control and Estimation Tools
Manager Projects (p. 4-3)

Opening Control and Estimation
Tools Manager Projects (p. 4-4)

A brief discussion of handling
multiple projects with multiple tasks

How to save projects for later

How to open existing projects
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4-2

Multiple Projects and Tasks

The Control and Estimation Tools Manager works seamlessly with products
in the Controls and Estimation family. In particular, if you have licenses
for Simulink Control Design or Model Predictive Control, you can use these
products to perform tasks on projects that you have created in Simulink

Parameter Estimation, and vice versa.

This figure shows a tools manager with multiple projects and multiple tasks.

= J: Control and Estimation Tools Manager

=]
File Wiew Help
= = = I )
L Workspace ~Task setting
= ﬂ Project - engine_idle_speed Title: I
5] Estimation Task
= Project - watertank Subject: I
5] Estimation Task uthor |
= ﬂ Project - maghall or:
Cperating Points Companty: I
fﬁ Default Operating P
Description: ;I
rﬁ Transient Data
l:'- “ariables
[ Estimation
(g validation
=
Macdlel: ThPdemo Open Madel Update Task |
Kl | o
Tteration 15 complete ;I
Estimation completed.

Select the nodes below to configure and run estimations.

R

You can save projects individually, or group multiple projects together in one

saved file. This chapter describes how to do this.



Saving Control and Estimation Tools Manager Projects

Saving Control and Estimation Tools Manager Projects

A Control and Estimation Tools Manager project can consist of multiple
tasks including those from Simulink Control Design, Simulink Parameter
Estimation, and the Model Predictive Control Toolbox. Each task contains
data, objects, and results for the analysis of a particular model.

To save your project as a MAT-file, select File > Save in the Control and
Estimation Tools Manager window.

<) Save Projects [_ [
Projects:
Project 114 |
=
Ol | Cancel | Help |

To save multiple projects within one file:

1 In the Save Projects dialog box, select the projects that you want to save.

2 Click OK.

3 Choose a directory and name for your project file by either browsing for a
file or typing the full path and filename in the Save as field. Click Save.
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Opening Control and Estimation Tools Manager Projects

To open previously saved projects, select File > Load in the Control and
Estimation Tools Manager window.

<} Load Projects [ [O] |

Projects:

Project 114 |

=

Load frarm; I’E:l"DESh‘tDp"PrDjEC’t-f14.ma‘t |

Cil | Cancell Help |

In the Load Projects dialog box, choose a project file by either browsing for
the directory and file, or by typing the full path and filename in the Load
from field. Project files are always MAT-files. The projects within this file
appear in the Projects list.

Select the projects that you want to load, then click OK. When a file contains
multiple projects, you can choose to load them all or just a few.
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What Are Lookup Tables?

Lookup tables are used to store numeric data in a multidimensional array
format. In the simpler two-dimensional case, lookup tables can be represented
by matrices. Each element of a matrix is a numerical quantity, which can be
precisely located in terms of two indexing variables. At higher dimensions,
lookup tables can be represented by multidimensional matrices, whose
elements are described in terms of a corresponding number of indexing
variables.

Lookup tables provide a means to capture the dynamic behavior of a physical
(mechanical, electronic, software) system. The behavior of a system with

M inputs and N outputs can be approximately described by using N lookup
tables, each consisting of an array with M dimensions.

Lookup tables are usually generated by experimentally collecting or
artificially creating the input and output data of a system. In general, as
many indexing parameters are required as the number of input variables.
Each indexing parameter may take a value within a predetermined set of
data points, which are called the breakpoints. The set of all breakpoints
corresponding to an indexing variable is called a grid. So, a system with

M inputs is girded by M sets of breakpoints. Given the input data, the
breakpoints are then used to locate the array elements, where the output data
of the system are stored. For a system with N outputs, N array elements are
located and the corresponding data are stored at these locations.

Once a lookup table is created using the input and output measurements as
described previously, the corresponding multidimensional array of values
can be used in applications without the need of remeasuring the system
outputs. In fact, only the input data is required to locate the appropriate
array elements in the lookup table and the approximate system output can
be read from the data stored at these locations. Therefore, a lookup table
provides a suitable means of capturing the input-output mapping of a static
system in the form of numeric data stored at predetermined array locations.
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How Adaptive Lookup Tables Work

The generation of lookup tables as described previously, establishes a
permanent and static mapping of input-output behavior of a physical system.
Statically defined lookup tables cannot accommodate the time-varying
behavior (characteristics) of a physical plant. On the other hand, it is well
known that the behavior of actual physical systems often vary with time due
to wear, environmental conditions, and manufacturing tolerances. Under such
variations, the static mapping of input-output behavior of a plant described
by the lookup table may no longer provide a valid representation of the plant
characteristics.

Adaptive lookup tables, on the other hand, incorporate the time-varying
behavior of physical plants into the lookup table generation and maintenance
process while providing all of the functionality of a regular lookup table.

The adaptive lookup table receives the input and output measurements of a
plant’s behavior, which are then used to dynamically create and update the
content of the underlying lookup table. In addition to requiring the input data
to create the lookup table, the adaptive lookup table also uses the output
data of the plant to recalculate the table values. As an example, the output
data of the plant can be collected by placing sensors at appropriate locations
in a physical system.

The input measurements are used to locate the array elements by comparing
these input values with the breakpoints defined for each indexing variable.
Next, the output measurements are used to recalculate the numeric value
stored at these array locations. However, unlike a regular table, which only
stores the array data before the actual use of the lookup table, the adaptive
table continuously improves the content of the lookup table. This continuous
improvement of the table data is referred to as the adaptation or learning
process.

The adaptation process involves statistical and signal processing algorithms
to recapture the input-output behavior of the plant. The adaptive lookup
table always tries to provide a valid representation of the plant dynamics
even though the plant behavior may be time varying. The underlying signal
processing algorithms are also robust against reasonable measurement noise
and they provide appropriate filtering of noisy output measurements.
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Implementation of Adaptive Lookup Tables

In this section...

“Simulink Blocks for Adaptive Lookup Tables” on page 5-4
“Adaptive Lookup Table Library” on page 5-5

“Using Adaptive Lookup Tables in Simulink Models” on page 5-6
“Real-Time Lookup Tables” on page 5-6

“Setting Adaptive Lookup Table Parameters” on page 5-7

“Selecting an Adaptation Method” on page 5-8

Simulink Blocks for Adaptive Lookup Tables

The MathWorks implements Adaptive Lookup Tables as Simulink blocks.
These blocks create multidimensional lookup tables from measured or
simulated data. The inputs and outputs of a n-D Adaptive Lookup Table
block with two inputs are shown next.

u 2-D1E§j v

Enahle

Lock Tout b

Adaptive Lookup
Tahle (Nl Stair-Fit)

Adaptive Lookup Table Block Showing Inputs and Outputs

The following are descriptions of the input and output parameters:

¢ The inputs u and y are the coordinate data and system output
measurements, respectively. For example, if you want to create a lookup

table to model the behavior of an engine’s efficiency as a function of engine
rpm and manifold pressure,u = [rpm, pressure] andy = [efficiency].
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® The initial table data may be entered either as a dialog box parameter
(by double-clicking the block) or as an input port (i.e., the input port Tin
in the figure). You can start, stop, and reset the adaptation through the

Enable input port.

® The outputs of the block include the value of the currently adapted table
cell (Y), the number (N) of that cell (which may be specified through the
block dialog box), and if required, the whole adapted table data (Tout).

Adaptive Lookup Table Library

Three adaptive lookup tables are available in Simulink Parameter Estimation.
To access the Adaptive Lookup Tables library, type the following command at

the MATLAB prompt:

spelookup

E! Library: spelookup

File Edit Wwiew Format Help

=10l ]

Adaptive Lookup Tables

1.0 T(W)

2.0 T(W)

Adaptive Lookup
Tahle (1D Stair-Fit)

Adaptive Lookug
Tahle (20 Stair-Fit)

Sirmulink Parameter Estinmation 1.0

Adaptive Lookup
Tahle (D Stair-Fit)

Copyright [c) 2004-2004 The Mathworks, Inc.

The three blocks are

e Adaptive Lookup Table (1D Stair-Fit) — One-dimensional adaptive lookup
e Adaptive Lookup Table (2D Stair-Fit) — Two-dimensional adaptive lookup
¢ Adaptive Lookup Table (nD Stair-Fit) — Multidimensional adaptive lookup

(use this for dimension 3 or higher)
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Using Adaptive Lookup Tables in Simulink Models
A typical Simulink diagram using an adaptive lookup table block is shown
next.

E!usahility_adaptive_tahle - | Ellll
File Edit WYiew Simulation Format Tools Help

,—bx 2D Tixgl . Adapted Z value
*

_,—>Zin Gell Mo
H

bata ol ot
(21

Adaptiee Look-Up Cell number
Table (nD)

Ready [1o02 [ [ |odets v

Simulink Diagram Using an Adaptive Lookup Table

In this figure, the Experiment Data block imports a set of experimental data
into the Simulink environment through MATLAB workspace variables. The
initial table is specified through a constant matrix block. When the simulation
runs, the initial table begins to adapt to new data inputs and the resulting
table is copied to the block’s output.

Real-Time Lookup Tables

You can use experimental data from sensor measurements collected by
running various tests on a system in real time. The measured data is then
sent to the adaptive table block to generate a lookup table describing the
relation between the system inputs and output.

The Adaptive Lookup Table block may also be used in a real-time environment,
where some time-varying properties of a system need to be captured. This
can be done by generating C code using Real-Time Workshop®, which can
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then be run in an xPC or dSpace environment. Since the adaptation may be
started, stopped, or reset if desired, some logic may be used to adapt the table
data only when it is desired. The Cell No output, and the Enable and Lock
inputs facilitate this process. The Enable input is used to start and stop the
adaptation, while the Lock input is used to update only one of the table cells.
The Lock input combined with some logic using the Cell No output provide
the means for updating only the desired table cells during a simulation run.

Setting Adaptive Lookup Table Parameters

The Adaptive Lookup Table parameters are configured in the Function Block
Parameters dialog box. Double-click the Adaptive Lookup Tables Simulink
block to open this dialog box.
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E! Function Block Parameters: Adaptive Lookup T3

— &daptive Lookup T able (D] [mazk] [link)

these locations.

Perform adaptive table lookup. Breakpoints relate the coordinate inputs to cell
locations in the table. The data iz uzed to dwnamically update the cell walues at

r— Parameter

Mumber of table dimensions:

E

T able breakpoints [cell aray]:

Adaptive lookup

fi10,22.31 40), [10,22 31,40

[~ Make initial table an input
T able data (initial):

table dimensions

Block input values for input

[456161920101823)

T able numbering data:

variables

1234567849

Adaptation method: ISampIe mean [with forgetting)
Adaptation gain (0ta 1)

[E

™ Make adapted table an output

[ Add adaptation enable/disable/reset port
[~ Add cell lock enable/disable port

Action for out-af-range input |l grore

i

Ok, I Cancel |

Apply

n-D Adaptive Lookup Table Dialog Box

Initial table output values

Number values assigned to cells

Algorithm for adaptation

Assign weight to new data

Customize block I/O channels

Allow adaptation for out-of-range
data

For details on how to set these parameters, see the individual Chapter 7,

“Blocks — Alphabetical List” reference pages.

Selecting an Adaptation Method

You can choose Sample mean or Sample mean (with forgetting) as the
Adaptation Method in the Function Block Parameters dialog box. This
section discusses the details of these algorithms.
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Sample Mean

Sample mean provides the average value of n output data samples and is
defined as:

Y =23 di)
nia

where d(i) is the i» measurement collected within a particular cell. For each
input data pair(x1, x2), the sample mean at the corresponding cell is
updated using the output data measurement, d. Instead of accumulating n
samples of data for each cell, a recursive relation is used to calculate the
sample mean. The recursive expression is obtained as follows:

= n-1| 1 = | 1 n-1 1
y(n) = ;[2 d@)+ d(n)} = T{E z d(l)} + ;d(n) = Ty(n -D+ ;d(n)

i=1 =1

where d(n) is the n* data sample. Defining a priori estimation error as

e(n) =d(n)—y(n-1), the recursive relation can be written as:

1
y(n)=y(n-1+ ;e(n)
where n >1 and the initial estimate y(0) is arbitrary.

In this expression, instead of n data samples, only the number of samples,
n, for each cell is stored in memory.

Sample Mean with Forgetting

The adaptation method “Sample Mean” on page 5-9 has an infinite memory.
The past data samples have the same weight as the final sample in calculating
the sample mean. Sample mean (with forgetting) uses an algorithm with
a forgetting factor or Adaptation gain that puts more weight on the more
recent samples. This algorithm provides robustness against initial response
transients of the plant and an adjustable speed of adaptation. Sample mean
(with forgetting) is defined as:
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5-10

n X n-1 . —
¥ = Y Al = ;{ > A + d<n>] = S(;‘(n)l) yn-1+ i) d(n)

i=1 s(n

Zi=17L =1 Z?ﬂ A

where Le[0,1] is the Adaptation gain and s(k) = Zleln_i . Defining a
priori estimation error as e(n)=d(n)—y(n —1), where n >1 and the initial

estimate y(0) is arbitrary, the recursive relation can be written as:

1-A

7\‘77.

e(n)

yn)=yn-D+ Le(n) =y(n-1)+
s(n)

A small value of A results in faster adaptation. A value of 0 indicates short
memory (last data becomes the table value), and a value of 1 indicates long
memory (average all data received in a cell).
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Example: n-D Adaptive Lookup Table

In this section...

“Loading the Example” on page 5-11

“Running the Example” on page 5-12

Loading the Example

This example shows an n-D adaptive lookup table at work and includes many
of the key features associated with adaptive lookup tables. Type

enginetable

at the MATLAB prompt to open this model.

Slenginetable 10l =|
File Edit WYiew Simulation Format Tools Help
DB2E&|sER o2 r s |om DBy hE@E T ®
Experimental Data
Adaptive Table Cutputs
¥
¥ ks Gell Number
o Enable N [T
—
Enahle Trigger
NOT GEmph Trigger F
? Lock Tout | Ackapted Tabie
L =
Lok —
Adaptive Lookup Efficiency Surtace
Table (D Stair-Fit)
G -
Gk Murnberof Test Points
Ready [1o02 |FixedstepDiscrate v

This model has several key features:
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¢ Input — The adaptive lookup table input is the experimental data. It is
also possible to make the original table itself an input.

® An enable feature — You can turn the adaptation on and off during the
estimation to see how the basic features work.

® A lock feature — You can lock the table so that only one cell is adapting.
This is useful if you have one section in your data that is highly erratic or
otherwise difficult for the algorithm to handle.

® QOutput — Adaptive lookup breakpoints are the output data.

Running the Example

To start the enginetable simulation, select Simulation > Start. Or, on
Microsoft Windows, click the Start Simulation button * in the Simulink
toolbar.

The simulation begins by populating the adaptive lookup table with random
data. This figure shows the input and adaptive data side by side.

<) Figure 1 =0 x|
§

File Edit Wiew Insert Tools Deskiop Window Help
DNEEE| k|eams |08 a0

Plant Surface using Measured Data Plant Surface using Adaptive Lookup Table (Stair-fit)

= =
o w —

o
~

“olumetric Efficiency
“aolumetric Efficiency

=
m

o - 5000
=0 - 4000
2000

Intake Manifald Pressure 00 Engine Speed (rpm) Intake Manifold Pressure 0n Engine Speed (ram)
(kPa) kPa)

As the simulation progresses, the surface on the right adapts to match the
measured input data. This figure shows the final adaptation.
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) Figure 1 =10 ﬂ
»

File Edit Wiew Insert Tools Deskiop Window Help
DEEE| k|®a®ms |08 a0

Plant Surface using Measured Data Plant Surface using Adaptive Lookup Table (Stair-fit)

:

»09 % 094
2 2
@ @
£ 08 £ 084
i il
2 2
£ £ 07
E =
= =
g =2 06+
100 NP el T 100
o T B0 : - 5000
50 . 4000 0 . 4000
2000 2000
Intake Manifald Pressure 00 Engine Speed (rpm) Intake Manifold Pressure 0 Engine Speed (rpm)
3 a
(kFa) {kPa)

The fit is quite good. Try using the enable and lock features to see how they
change the adaptation.

5-13



5 Adaptive Lookup Tables

5-14



Estimating from the
Command Line

Introduction (p. 6-3)

Example: Estimating Parameters
and Initial Conditions of the F14
Model (p. 6-5)

Creating and Customizing

Estimation Projects (p. 6-15)

Creating Transient Data Objects
(p. 6-16)

Creating State Data Objects (p. 6-21)

Creating Transient Experiment
Objects (p. 6-24)

Creating Parameter Objects (p. 6-27)

A brief discussion of the estimation
problem in an object-oriented context

How to create and simulate
an estimation project from the
command line

Using properties and methods to
specify features of the estimation
project

How to instantiate and use transient
data objects, which contain input
and output data

How to instantiate and use state data
objects, which contain information
about known states in your Simulink
model

How to instantiate and use
parameter objects, which maintain
data about parameters you want to
estimate

How to instantiate and use state
objects, which maintain data about
the block states you want to estimate



6 Estimating from the Command Line

Creating State Objects (p. 6-31)

Creating Estimation Objects (p. 6-35)

How to instantiate and use transient
experiment objects

How to instantiate and use
estimation objects, which coordinate
your model, experiment, parameter,
and state objects



Introduction

Introduction

In addition to the Control and Estimation Tools Manager, Simulink Parameter
Estimation provides a collection of functions for performing parameter

and state estimation. These functions perform the same tasks as the tools
manager, but have the advantages of command-line execution. When

you perform a state or parameter estimation using Simulink Parameter
Estimation GUI, Simulink Parameter Estimation creates MATLAB objects
for all the states and parameters of your model. If you have a large number
of states or parameters, this can use up large amounts of memory and cause
computational delays. With the command-line approach, only those states
and parameters that you select are assigned MATLAB objects, which is more
efficient.

In addition, the command-line approach is useful for batch jobs, where, for
example, you may want to test large numbers of models.

Note Simulink Parameter Estimation uses MATLAB objects to perform
estimation tasks. This chapter discusses what you need to know about
object-oriented programming for using Simulink Parameter Estimation,
but see the MATLAB Programming documentation for a description of
object-oriented programming in MATLAB.

The command-line interface for Simulink Parameter Estimation requires a
Simulink model as a starting point for analysis and estimation. Once you have
selected a candidate model, the estimation process consists of these steps:

1 Defining experiments consisting of empirical data sets and the operating
conditions and/or initial conditions of your model

2 Selecting the variables and states to be estimated
3 Performing the estimation
4 Reviewing the results and iterating as necessary

5 Validating estimation results
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The following sections discuss these topics:

o “Example: Estimating Parameters and Initial Conditions of the F14 Model”
on page 6-5 — How to perform the estimation process using command-line
functions

® “Creating and Customizing Estimation Projects” on page 6-15 — How to
use methods and properties to customize your estimation project’s features



Example: Estimating Parameters and Initial Conditions of the F14 Model

Example: Estimating Parameters and Initial Conditions
of the F14 Model

In this section...
“Loading the F14 Jet Model” on page 6-5

“Baseline Simulation” on page 6-6
“Creating a Transient Experiment Object” on page 6-8

“Assigning Experimental Data to Inputs and Outputs of the Model” on
page 6-9

“Creating Parameter Objects for Estimation” on page 6-10

“Creating an Estimation Object and Running the Estimation” on page 6-11

Loading the F14 Jet Model

To define an experiment, you must start with a Simulink model. For this
example, type

f14

to load the F14 fighter jet model into the MATLAB workspace. The following
figure shows the f14 model.
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F14 Fighter Jet Model

This example outlines the basics of constructing an estimation project using
object-oriented code. Only what you need to run the example is presented in
this section. See “Creating and Customizing Estimation Projects” on page
6-15 for details on all the properties and methods associated with parameter
estimation.

Baseline Simulation

Before running an estimation, you need a baseline for data comparison. First,
you must choose parameters and states’ initial conditions for estimation. This
example uses Ta, the actuator time constant, and Zd and Md, the vertical
velocity and pitch rate gains, respectively. Then use the following code to
run the Simulink f14 model. Note that this is standard Simulink code and
does not involve Simulink Parameter Estimation in any way. See sim in the
Simulink Reference documentation for information about running Simulink
models from the MATLAB command line.
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%% Open the model and load experimental data.
open_system('f14"')
load f14_estim % Load empirical I/0 data.

%% Set initialize unknown parameters
% Actuator time constant (ideal: Ta = 0.05)
Ta = 0.5;

% Aircraft dynamic model parameters (ideal: Md = -6.8847,
Zd = -63.998)
-1; Zd = -80;

o°

=

d

%% Plot measured data and simulation results

[T,X,Y] = sim('f14', time, [], [time iodata(:,1)]);

plot(time, iodata(:,2:3), T, Y, '-');

legend( 'Measured angle of attack', 'Measured pilot g force', ...
‘Simulated angle of attack', 'Simulated pilot g force');

The following figure appears.
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As you can see, the measured and simulated data are a poor match. The
rest of this section describes how to estimate values for Ta, Zd, and Md that
result in a better match of data sets.

Creating a Transient Experiment Object

After you have a model and identify the parameters you want to

estimate, the next step is to create the objects required for an estimation.
ParameterEstimator is both the name of the class and the object instantiated
by that class. Classes are created by a constructor; objects are created by
invoking the class name with parameters.

First, create an estimation project object. This is the constructor syntax:

hExp = ParameterEstimator.TransientExperiment('f14');

MATLAB responds with information about the f14 model.
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Experimental transient data set for the model 'f14':

Output Data
(1) f14/alpha (rad)
(2) f14/Nz Pilot (g)

Input Data
(1) f14/u

Initial States
(1) f14/Actuator Model

(2) f14/Aircraft Dynamics Model/Transfer Fcn.1

(3) f14/Aircraft Dynamics Model/Transfer Fcn.2

(4) f14/Controller/Alpha-sensor Low-pass Filter

(5) f14/Controller/Pitch Rate Lead Filter

(6) f14/Controller/Proportional plus integral compensator
(7) f14/Controller/Stick Prefilter

(8) f14/Dryden Wind Gust Models/Q-gust model

(9) f14/Dryden Wind Gust Models/W-gust model

Assigning Experimental Data to Inputs and Outputs
of the Model

After you create a ParameterEstimator object, assign input and output
experimental (i.e., empirical) data.

%% Create objects to represent the experimental data sets.
set(hExp.InputData(1), 'Data', iodata(:,1), 'Time', time);

set(hExp.OutputData(1), 'Data', iodata(:,2), 'Time',
time, 'Weight', 5);
set(hExp.OutputData(2), 'Data', iodata(:,3), 'Time', time);

Note In general, for models with multiple inputs and outputs, you must
independently assign one data object to each input and output port. The
data object you assign to a specific port can be a vector or a matrix that
corresponds to that channel. You cannot use a single I/O port to represent
multiple channels.




6 Estimating from the Command Line

Creating Parameter Objects for Estimation

To activate parameters for estimation, you must create parameter objects for
the parameters you want to estimate. For this example, use Ta, the actuator
time constant, and Zd and Md, the vertical velocity and pitch rate gains,
respectively. The Zd and Md gains are located in the F14 aircraft dynamics
subsystem.
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First, create ParameterEstimator objects for the parameters you want to
estimate.

%% Create objects to represent parameters.
hPar(1) = ParameterEstimator.Parameter('Ta');
set(hPar(1), 'Minimum', 0.01, 'Maximum', 1, 'Estimated', true)

hPar(2) = ParameterEstimator.Parameter('Md');
set(hPar(2), 'Minimum', -10, 'Maximum', O, 'Estimated', true)

hPar(3) = ParameterEstimator.Parameter('zd');
set(hPar(3), 'Minimum', -100, 'Maximum', 0, 'Estimated', true)

6-10



Example: Estimating Parameters and Initial Conditions of the F14 Model

%% Create objects to represent initial states.
hIc(1) = ParameterEstimator.State('f14/Actuator Model');
set(hIc(1), 'Minimum', O, 'Estimated', false);

You can also use dot notation here. For example, instead of

set(hPar(2), 'Minimum', -10, 'Maximum', O, 'Estimated', true)

you can write

hPar(2).Estimated=true;
hPar(2) .Minimum=-10;
hPar(2) .Maximum=0;

Creating an Estimation Object and Running the
Estimation

Finally, create an estimation object and run the estimation, using gcs to get
the full pathname to the Simulink model.

hEst = ParameterEstimator.Estimation(gcs, hPar, hExp);
hEst.States = hlc;

%% Setup estimation options
hEst.OptimOptions.Algorithm "1sgnonlin’;
hEst.OptimOptions.GradientType = 'refined';
hEst.OptimOptions.Display = 'iter';

%% Run the estimation
estimate(hEst);

%% Plot measured data and final simulation results
[T,X,Y] = sim('f14', time, [], [time iodata(:,1)]);

figure
plot(time, iodata(:,2:3), T, Y, ' ');
legend( 'Measured angle of attack', 'Measured pilot g force',

‘Simulated angle of attack', 'Simulated pilot g force');
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This figure shows the results of the estimation.
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The measured and simulated outputs now appear to be a close match. Next,
look at the estimated values to see how they compare with the default values
of the f14 model.

%% Look at the estimated values
find(hEst.Parameters, 'Estimated', true)
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MATLAB responds with

(1) Parameter data for

Parameter value
Initial guess

Estimated

0.
;0.

‘Ta':

05
5

. true

Referenced by:

(2) Parameter data for

Parameter value
Initial guess

Estimated

‘Md " :

-6.884
-1

true

Referenced by:

(3) Parameter data for

Parameter value
Initial guess

Estimated

‘Zd':

-63.99
-80

. true

Referenced by:
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Note You can use the find command to identify scalar, vector, or matrix
parameters. The dimensions of the Estimated value you specify as the find
argument must match the dimensions of the parameters you are trying to
find. For example,

find(hEst.Parameters, 'Estimated', true)

finds only scalar estimated parameters. However,

find(hEst.Parameters, 'Estimated', [true;true])

finds only vector estimated parameters with dimensions 1-by-2 and excludes
all scalar parameters.

You can verify that these values match the default values of the f14 model by
clearing your workspace, loading the model, and checking the values.

clear all
f14
whos



Creating and Customizing Estimation Projects

Creating and Customizing Estimation Projects

The following sections describe in more detail how to create and modify
transient data and estimation objects:

® “Creating Transient Data Objects” on page 6-16

® “Creating State Data Objects” on page 6-21

¢ “Creating Transient Experiment Objects” on page 6-24

® “Creating Parameter Objects” on page 6-27

® “Creating State Objects” on page 6-31

® “Creating Estimation Objects” on page 6-35

First, a quick look at terminology:

e QObjects are instantiations of classes.
® (Classes contain, or rather, define, properties and methods.

® You use a constructor to create an instance of an object, and use the set
method or dot notation to modify the properties of your objects.
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Creating Transient Data Obijects

e “What is a Transient Data Object” on page 6-16

¢ “Constructor” on page 6-16

e “Properties of Transient Data Objects” on page 6-17

® “Modifying Properties of Transient Data Objects” on page 6-19
e “Using Class Methods” on page 6-20

What is a Transient Data Object

The @TransientData object encapsulates the data measured at a single input
or output of a physical system during an experiment. Transient data objects
are associated with three types of Simulink blocks:

¢ Inport blocks
¢ Qutport blocks

¢ Internal blocks used in conjunction with signal logging.

Each @TransientData object describes the time history of a signal at a
Simulink port. A data set is identified by the Block property of this object
corresponding to a block name in the Simulink model. A PortNumber value
is also necessary for internal blocks to uniquely identify signals within the
block diagram.

Constructor

Estimating parameters requires a transient data object, which you create
using a constructor. The syntax to create a transient data object is

% I/0 port block

h = ParameterEstimator.TransientData('block');

% Internal block

h = ParameterEstimator.TransientData('block',portnumber);

h = ParameterEstimator.TransientData('block',data,time);

h = ParameterEstimator.TransientData('block',data,Ts);

h = ParameterEstimator.TransientData('block',portnumber,data,time);
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h = ParameterEstimator.TransientData('block',portnumber,data,Ts);

Properties of Transient Data Objects

Descriptions of properties of the transient data object and the associated
input parameters are as follows.

Transient Data Object Properties

Property

Description

Block

Name of the Simulink block with which the data is
associated. Must be a string.

PortType

The type of signal that this object represents is determined
in the constructor from the Block property, which may be
Inport, Outport, or Signal.

PortNumber

For data associated with the outputs of regular blocks
or subsystems, this property specifies the output port
number of interest. The default value is 1.

Dimensions

Dimensions of the data required for this data set. It is
computed from the CompiledPortDimensions property of
the appropriate port of the block, and it defines the size
of other properties. Currently, Simulink supports scalar,
vector, or matrix signals, so Dimensions is either a scalar
or a 1-by-2 array.

Data

Actual experimental data. Its size must be consistent
with the Dimensions property. To conform with Simulink
conventions, the data is stored in the following formats:

e Scalar or vector-valued data. The data is of the form Ns
m, where Ns is the number of data samples, and m is
the number of channels in the signal.

e Multidimensional data (matrix and higher dimensions).
The data is of the form m1 . . . mn Ns, where Ns is
the number of data samples, and mi is the number of
channels in the ith dimension of the signal.

¢ For missing or unspecified data, NaNs are used.
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Transient Data Object Properties (Continued)

Property Description
Ts, For uniformly sampled data, Ts is the sample time and
Tstart, Tstart is the start time of the signal. The stop time Tstop
Tstop and the time vector Time are given by
Tstop = Tstart + Ts * (Ns -1)
Time = Tstart : Ts : Tstop
For nonuniform time data, Ts is set to NalN, and the start
and stop times are calculated from the time vector.
Time The time data in column vector format. The length of Time

must be consistent with the number of samples in Data.

For a nonuniformly spaced Time vector, its length should
match the length of Data.

Otherwise, Time is automatically adjusted based on the
length of Data.

Modifying Ts resets Time internally. In this case, Time is
a virtual property whose value is computed from Ts and
Tstart when you request it. The rules for setting time
related properties are

¢ Modifying Time sets

Ts = NaN
Tstart = Time(1)

¢ [fthe time vector is uniformly spaced, a sample time
Ts is calculated.
¢ Modifying Tstart translates time forward or backward.

¢ Modifying Ts sets Time = [] internally and generates
it when required by the simulation.
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Transient Data Object Properties (Continued)

Property Description

Weight The weight associated with each channel of this data set.
It is used to specify the relative importance of signals.
The default value is 1.

InterSample Interpolation method between samples can be zero-order
hold (zoh) or first-order hold (foh). This property is used
for data preprocessing.

Modifying Properties of Transient Data Obijects

After a transient data object is created, you can modify its properties using
this syntax:

int1.Data = rand(2,1,10); % 10 data values each of size [2 1]
in1.Time 1:10; % Automatically converted to column vector

Some properties (e.g., Weight) support scalar expansion with respect to the
value of the Dimensions property.

Example: Assigning Input Port Data
To assign data to an input port with 2-by-3 port dimensions, use

in1 = ParameterEstimator.TransientData(gcb, rand(2,3,100), 0.05)
MATLAB responds with

(1) Transient data for Inport block 'portdata_test_noSim/By//Pass

Air Valve Voltage':

Sampling interval: 0.05 sec.
Data set has 100 samples and 6 channels.
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Using Class Methods

Descriptions of two important methods are given next:

® select — Extracts a portion of data. The result is returned in a new
transient data object.

in2 = select(in1, 'Sample', 10:100); % 91 samples
in3 select(in1, 'Range', [1 4]); % Samples for 1<t<4

% ... or an alternative
in3 = select(in1, 'Sample', find(in1.Time > 1 & in1.Time < 4));

To extract data from a subset of available channels, use

in4 = select(ini1, 'Channel', [1 3 2]);
% channels 1,3,and 2 in this order

e hiliteBlock — Highlights the block associated with this object in the
Simulink diagram.
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Creating State Data Objects

In this section...
“What is a State Data Object” on page 6-21

“Constructor” on page 6-21

“Properties of the State Data Object” on page 6-22
“Example: Initial Condition Data” on page 6-23
“Modifying Properties” on page 6-23

“Using Class Methods” on page 6-23

What is a State Data Object

The ParameterEstimator.StateData object defines the states of a dynamic
Simulink block. It is used in a transient estimation context to define known
initial conditions of a block diagram model, and in a steady-state estimation
context to define the known states of the model.

For example, the Simulink model of a simple mass-spring-damper system
has two integrator blocks to generate velocity and position signals from
acceleration and velocity values, respectively, during simulation. If the
corresponding physical system is known to be at rest at the beginning of an
experiment, the initial states (velocity and position) of these integrators are
zero. So, two @StateData objects can be created to describe these known
initial conditions.

Constructor
The syntax for creating this object is

h
h

ParameterEstimator.StateData('block');
ParameterEstimator.StateData('block', data);

In the first constructor, the state vector is initialized from the model
containing the block.
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Properties of the State Data Object

Descriptions of some important properties are given in the following table .

State Data Object Properties

Property

Description

Block

Name of the Simulink block whose states are defined
by this object.

Dimensions

Scalar value to store the number of states of the relevant
block.

Data

Column vector to store the initial value of the state

for the block specified by this object. The length of

this vector should be consistent with the Dimensions
property. Since the underlying Simulink model also
stores an initial state vector for all dynamic blocks, the
following conventions are used to resolve the initial state
values during estimations:

e If Data is not empty, use it when forming the state
vector.

¢ If Data is empty, get the state vector for this block
from the model. This behavior is useful when using
helper methods to create an experiment object that
instantiates empty state data objects for all dynamic
blocks in the Simulink model.

¢ If there is no state data object for a dynamic block in
the model, get the state vector of that block from the
model. This behavior is useful for command-line users,
when there are too many states in the model and only
a few of them have to be set to different initial values.

Ts

Sampling time of discrete blocks. Set to 0 for continuous
blocks. This property is read only and is currently used
for information only.

Domain

String to hold the physical domain of the block. Used for
SimMechanics or SimPowerSystems blocks with states.
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Example: Initial Condition Data

To create an empty initial condition object for the engine_idle speed/
TransferFcn2, use

st1 = ParameterEstimator.StateData ...
('engine_idle_speed/Transfer Fcn2', [1 2])

(1) State data for 'f14/Dryden Wind Gust Models/W-gust model'
block:

The block has 2 continuous state(s).

State value : [1;2]

Modifying Properties
After a state data object is created, you can modify its properties using this
syntax:

st1.Data = [2 3]; % State vector of size 2

Some properties (e.g., Data) support scalar expansion with respect to the
value of the Dimensions property.

Using Class Methods

Description of two important methods are given next:
e hiliteBlock — Highlights the block associated with this object in the
Simulink diagram.

¢ update — Updates the object after the Simulink model has been modified.
If the Dimensions property value changes, the other properties are reset to
their default values.
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Creating Transient Experiment Objects

In this section...

“What is a Transient Experiment Object” on page 6-24
“Constructor” on page 6-24

“Properties of Transient Experiment Objects” on page 6-24
“Example: Creating an F14 Experiment” on page 6-25

“Example: Creating a Van der Pol Experiment from User Objects” on page
6-26

“Modifying Properties” on page 6-26
“Using Class Methods” on page 6-26

What is a Transient Experiment Object

The @TransientExperiment object encapsulates the data measured at the
input and output ports of a system during a single experiment, as well as the
system’s known initial states.

Constructor
The syntax to create a transient experiment object is

h = ParameterEstimator.TransientExperiment('model’);

where model specifies the name of the Simulink model.

Properties of Transient Experiment Objects
Descriptions of some important properties are given in the following table.
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Transient Experiment Object Properties

Property

Description

Model

Simulink model with which this experiment is
associated.

InputData,
OQutputData

Transient data objects associated with appropriate I/O
blocks in the model. Blocks with unassigned objects
or objects with no data are not used in estimations,
meaning:

¢ For input ports, assign zeros to these ports/channels
during simulation.

® For output ports, don’t use these ports/channels in
the cost function.

InitialStates

State data objects associated with appropriate dynamic
blocks in the model.

InitFcn

Function to be executed to configure the model for this
particular experiment.

Example: Creating an F14 Experiment

To create an empty transient experiment for the f14 model, use

expl = ParameterEstimator.TransientExperiment('f14"')
Experimental (Transient) data set for the model 'f14':

Outputs

(1) f14/alpha (rad)
(2) f14/Nz Pilot (g9)

Inputs
(1) f14/u

Initial States

(1) f14/Actuator Model

2

3
4
5

—_— o~ o~ o~
~ — ~— ~—

f14/Aircraft Dynamics Model/Transfer Fcn.1

f14/Aircraft Dynamics Model/Transfer Fcn.2

f14/Controller/Alpha-sensor Low-pass Filter
f14/Controller/Pitch Rate Lead Filter
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f14/Controller/Proportional plus integral compensator
f14/Controller/Stick Prefilter
f14/Dryden Wind Gust Models/Q-gust model

(6
(7
(8
(9) f14/Dryden Wind Gust Models/W-gust model

~ — ~— ~—

Example: Creating a Van der Pol Experiment from
User Objects

To create a transient experiment from user objects for I/Os and states, use

out1 = ParameterEstimator.TransientData('vdp/Outi1');
ic1 = ParameterEstimator.StateData('vdp/x1');

expl = ParameterEstimator.TransientExperiment...
(ges, [1, outl, icl);

Experimental (Transient) data set for the model 'vdp':
Outputs

(1) vdp/Out1

Inputs

(none)

Initial States

(1) vdp/x1

Modifying Properties
The objects referred in InputData, OutputData, and InitialStates
properties can be modified or removed as necessary.

Using Class Methods

The description of one important method is given next:

update — Updates the object after the Simulink model has been modified.
The object listed in the InputData, OutputData, and InitialStates
properties are updated in turn.
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Creating Parameter Objects

In this section...

“What is a Parameter Object” on page 6-27
“Constructor” on page 6-27

“Properties of Parameter Objects” on page 6-27
“Example: F14 Model” on page 6-29

“Example: Gain Matrix” on page 6-30
“Modifying Properties” on page 6-30

“Using Class Methods” on page 6-30

What is a Parameter Object

The @Parameter object refers to the parameters of the Simulink model marked
for estimation. Some of the Simulink model parameters are to be estimated
and storage is required for the initial values, current values, ranges, etc. One
@Parameter object corresponds to each parameter in the Simulink model to be
potentially estimated. These objects represent estimation parameters of any
type such as scalars, vectors, and multidimensional arrays.

Constructor
The syntax to create a parameter object is

h = ParameterEstimator.Parameter('Name');
h = ParameterEstimator.Parameter('Name', Value);
h = ParameterEstimator.Parameter('Name', Value, Minimum,

Maximum) ;
In the first case, Name is a workspace variable. In the other cases, Name does

not need to exist in the workspace at the time of object creation. However, it is
required at estimation time.

Properties of Parameter Objects
Descriptions of some important properties are given in the following table.
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Parameter Object Properties

Property Description

Name Parameter name. The parameter can be a
multidimensional array of any size.

Dimensions Dimensions of the value of the parameter. This is the
defining property for the size of other properties.

Value The current or estimated value of the parameter. This
is the defining property for size checking and scalar
expansions.

Estimated A Boolean array of the same size as that of Value.

Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
Value is as follows:

¢ The elements of Value is estimated if the corresponding
elements in Estimate are set to true. The result is
stored in the Value property.

® The elements of Value are not estimated if the
corresponding elements in Estimated are set to
false. However, these elements are used to reset
the corresponding workspace parameter during
estimations.

This property is set to false by default, meaning that
the parameter value is not estimated.
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Parameter Object Properties (Continued)

Property

Description

InitialGuess

Separate properties are required to hold the initial

and current values of the parameters. So, when the
InitialGuess property is initialized with a value, both it
and the Value property are assigned the same value.
Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
InitialGuess is as follows:

e If any element in Estimated is set to true, then the
corresponding element of InitialGuess is used to
initialize the workspace parameter during estimations.

® If any element in Estimated is set to false, then the
corresponding element of InitialGuess is not used
in any way.

Minimum,
Maximum

Parameter range.

TypicalValue

The typical values of the parameters. This property is
used in estimations for scaling purposes. The default
value is 1.

Example: F14 Model

To create a parameter object for the parameter Ta in the f14 model, use

pari = ParameterEstimator.Parameter('Ta')
(1) Parameter data for 'Ta':
Parameter value : 0.05

Initial value
Estimated :

: 0.05

false

Referenced by the blocks:
f14/Actuator Model
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Example: Gain Matrix
To create a parameter object for a matrix parameter K of size 4-by-1, use

pari = ParameterEstimator.Parameter('K', [1 2 3 4]"')
(1) Parameter data for 'K':

Parameter value : [1;2;3;4]
Initial value : [1;2;3;4]
Estimated elements : [false;false;false;false]

Referenced by the blocks:

Modifying Properties
After a parameter object is created, you can modify its properties using this
syntax:

pari.Estimated = true; % Estimate this parameter

Most of the properties, for example, Estimated and TypicalValue support
scalar expansion with respect to the size of Value.

Using Class Methods

Descriptions of two important methods are given next:

e hiliteBlock — Highlights the referenced blocks associated with
parameter objects in the Simulink diagram.

¢ update — Updates the parameter object after the Simulink model has
been modified. If the size of the Value property changes, then the other
properties are reset to their default values.
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Creating State Objects

In this section...
“What is a State Object” on page 6-31

“Constructor” on page 6-31

“Properties of State Objects” on page 6-31
“Example: F14 Model” on page 6-33
“Modifying Properties” on page 6-34
“Using Class Methods” on page 6-34

What is a State Object

The @State object is similar to the @Parameter object. One @State object
corresponds to each Simulink block with states in the model.

Constructor

The syntax to create a state object is

h = ParameterEstimator.State('block');
h = ParameterEstimator.State('block', Value);
h = ParameterEstimator.State('block', Value, Minimum,

Maximum) ;

In the first case, the state vector is initialized from the model containing the
block. In the other cases, block does not need to exist in the workspace at
the time of object creation. However, it is required at estimation time.

Properties of State Objects

Descriptions of some important properties of state objects are given in the
following table.
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State Object Properties

Property Description

Block Name of the Simulink block whose states are defined
by this object.

Dimensions Scalar value to store the number of states of the relevant
block.

Value Column vector to store the value of the state for the
block specified by this object. The length of this vector
should be consistent with the Dimensions property.

Estimated A Boolean array of the same size as that of Value.

Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
Value is as follows:

¢ The elements of Value are estimated if the
corresponding elements in Estimate are set to true.
The result is stored in the Value property.

® The elements of Value are not estimated if the
corresponding elements in Estimated are set to
false. However, these elements are used to reset the
corresponding states during estimations.

This property is set to false by default, meaning that
the state value is not estimated.
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State Object Properties (Continued)

Property Description

InitialGuess Separate properties are required to hold the initial and
current values of the states. So, when the InitialGuess
property is initialized with a value, both it and the
Value property are assigned the same value.
Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
InitialGuess is as follows:

e If any element in Estimated is set to true, then the
corresponding element of InitialGuess is used to
initialize the state during estimations.

® If any element in Estimated is set to false, then the
corresponding element of InitialGuess is not used
in any way.

Minimum, State vector range.
Maximum

TypicalValue The typical values of the states. This property is used in
estimations for scaling purposes. The default value is 1.

Ts Sampling time of discrete blocks. Set to zero for
continuous blocks. This property is read-only and is
currently used for information only.

Domain String to hold the physical domain of the block. Used for
SimMechanics or SimPowerSystems blocks with states.

Example: F14 Model

To create a state object for the f14/Actuator Model block in the f14 model,
use

st1 = ParameterEstimator.State(gchb)

MATLAB returns
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(1) State data for fi14/Actuator Model block:
The block has 1 continuous state(s).

State value : 0O
Initial guess : O
Estimated : false

Modifying Properties

After a state object is created, you can modify its properties using this syntax:

ic1.Estimated = true; % Estimate this state

Most of the properties, for example, Estimated and TypicalValue, support
scalar expansion with respect to the size of Value.

Using Class Methods

Description of two important methods are given next:

e hiliteBlock — Highlights the referenced blocks associated with state
objects in the Simulink diagram.

® update — Updates the state object after the Simulink model has been
modified. If the size of Value property changes, then the other properties
are reset to their default values.
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Creating Estimation Objects

In this section...

“What is an Estimation Object” on page 6-35
“Constructor” on page 6-35

“Properties of Estimation Objects” on page 6-35
“Example: F14 Model” on page 6-37
“Modifying Properties” on page 6-37

“Using Class Methods” on page 6-37

What is an Estimation Object

The @Estimation object is the coordinator between the model, experiments,
and parameter objects.

Constructor

The @Estimation object is the coordinator of the model, experiment, and
parameter objects. The syntax to create an estimation object is

h = ParameterEstimator.Estimation('model');
h = ParameterEstimator.Estimation('model', hParam);
h = ParameterEstimator.Estimation('model', hParam, hEXxps);

Properties of Estimation Objects

Descriptions of some important properties of estimation objects are given
in the following table.

Estimation Object Properties

Property Description

Model Name of the Simulink model with which this estimation
is associated.
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Estimation Object Properties (Continued)

Property

Description

Experiments

Experiments to be used in estimations. For multiple
experiments, the cost function uses a concatenation of the
output error vectors obtained using each experimental
data set.

Parameters

Parameter objects to be used in estimations.

States

State objects to be used in estimations. This is a handle
matrix with as many columns as there are experiments,
and as many rows as there are states in Model.

The handle matrix is created automatically in

the constructor. You can reorganize its rows

to specify shared states between experiments,

and set the Estimated flag of desired states.

If state data is provided in an experiment, the state
objects stored in the columns of this matrix are initialized
from the experiments.

SimOptions

Same as simset structure. This property is initialized to
simget(this.Model).

OptimOptions

Same as optimset structure.

EstimInfo

This property is used to store estimation-related

information at each iteration of the optimizer, and is

initialized as

this.EstimInfo = struct( 'Cost', [1,...
‘Covariance', [],...
"‘FCount', [],...
'‘FirstOrd', [1,...
‘Gradient', [1,...
‘Iteration', [],...
‘Procedure', [1,...
'StepSize', [1,...
‘Values', [] );




Creating Estimation Obijects

Example: F14 Model

To create an estimation object for the f14 model to estimate the parameters
Ta and Kf and two states, use

expi ParameterEstimator.TransientExperiment(gcs);

pari ParameterEstimator.Parameter('Ta', 'Estimated', true);
par2 = ParameterEstimator.Parameter('Kf', 'Estimated', true);
est1 = ParameterEstimator.Estimation(gcs, [parl, par2], expil);
est1.States(1,1).Estimated = true;

est1.States(6,1).Estimated = true;

est1

MATLAB returns

Estimated variables for the model 'f14':
Estimated Parameters

Using Experiments
(1) f14 experiment

Estimated States for Experiment 'f14 experiment'
(1) f14/Actuator Model
(6) f14/Controller/Proportional plus integral compensator

Modifying Properties
After an estimation object is created, you can modify its properties using
this syntax:

est.OptimOptions.Algorithm = 'fmincon'; % Estimation method
est.OptimOptions.Display = 'iter'; % Show estimation information
...1n workspace

est.Parameters(1).Estimated = false; % Do not estimate first
...parameter

est.States(2,3) .Estimated = false; % Do not estimate second state
...0f third expression

Using Class Methods

Descriptions of some of the important methods are given next:
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compare — Compares an experiment and a simulation.

simulate — Simulates the model with current parameters and states.
estimate — Runs an estimation.

restart — Restarts an estimation after it has finished running.

update — Updates the estimation object after the Simulink model has
been modified.
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Blocks — Alphabetical List

Adaptive Lookup Table (1D Stair-Fit)
Adaptive Lookup Table (2D Stair-Fit)
Adaptive Lookup Table (nD Stair-Fit)



Adaptive Lookup Table (1D Stair-Fit)

7-2

Purpose

Description

Data Type
Support

Perform one-dimensional adaptive table lookup

10 T(u)

The Adaptive Lookup Table (1D Stair-Fit) block creates a
one-dimensional adaptive lookup table by dynamically updating the
underlying lookup table. The block uses the outputs, ydata, of your
system to do the adaptations.

Each indexing parameter U may take a value within a set of adapting
data points, which are called breakpoints. Two breakpoints in each
dimension define a cell. The set of all breakpoints in one of the
dimensions defines a grid. In the one-dimensional case, each cell has
two breakpoints, and the cell is a line segment.

You can use the Adaptive Lookup Table (1D Stair Fit) block to model
time-varying systems.

Doubles only



Adaptive Lookup Table (1D Stair-Fit)

Dialog

Box

ZIFunction Block Parameters: Adaptive Lookup T2 |

— Aidaptive Lookup T able [10] [mazk] [link]

Perform adaptive table lookup. Breakpoints relate the coordinate inputs to cell
locations in the table. The data is uzed to dynamically update the cell values at
these locations.

— P |
Fararneter

First input [row] break point set:
Jr0.22.31.400

[ Make iritial table &t input
Table data [initial]:

458

Table numbering data:
nz3

Adaptation method: ISampIe mean [with forgetting) ;I

Adaptation gain [0 to 1);
Jog

[ Make adapted table an output

[~ Add adaptation enable/disable/iaset port
[ Add cell lack enable/disable port

Awction for out-of-range input |l gnore LI

Ok I Cancel | Help | Apply |

First input (row) breakpoint set
The vector of values containing possible block input values. The
input vector must be monotonically increasing.

Make initial table an input
Selecting this check box forces the Adaptive Lookup Table (1D
Stair-Fit) block to ignore the Table data (initial) parameter.
Instead, a new port appears with Tin next to it. Use this port
to input table data.

Table data (initial)
The initial table output values. This vector must be of size N-1,
where N is the number of breakpoints.
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Table numbering data
Number values assigned to cells. This vector must be the same
size as the table data vector, and each value must be unique.

Adaptation method
Choose Sample mean or Sample mean (with forgetting).
Sample mean averages all the values received within a cell.
Sample mean with forgetting gives more weight to the new
data. How much weight is determined by the Adaptation gain
parameter. For more information, see “Selecting an Adaptation
Method” on page 5-8.

Adaptation gain (0 to 1)
A number between 0 and 1 that regulates the weight given to new
data during the adaptation. A 0 means short memory (last data
becomes the table value), and 1 means long memory (average all
data received in a cell).

Make adapted table an output
Selecting this check box creates an additional output port for the
adapted table.

Add adaptation enable/disable/reset port
Add an input port that enables, disables, or resets the adaptive
lookup table. 0 = disable; 1 = enable; 2 = reset to initial table data.

Add cell lock enable/disable port
A port that provides the means for updating only specified cells
during a simulation run. 0 = unlock; 1 = lock current cell.

Action for out-of-range input
Ignore or Adapt by extrapolating beyond the extreme breakpoints.
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Purpose

Description

Perform two-dimensional adaptive table lookup

2-DT(u)

The Adaptive Lookup Table (2D Stair-Fit) block creates a
two-dimensional adaptive lookup table by dynamically updating the
underlying lookup table. The block uses the outputs (ydata) of your
system to do the adaptations.

Each indexing parameter U may take a value within a set of adapting
data points, which are called breakpoints. Two breakpoints in each
dimension define a cell. The set of all breakpoints in one of the
dimensions defines a grid. In the two-dimensional case, each cell has
four breakpoints and is a flat surface.

You can use the Adaptive Lookup Table (2D Stair-Fit) block to model
time-varying systems.
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L]
Function Block Parameters: Adaptive Lookup TS x
Dialo lock d ki
Box — Adaptive Lookup Table [20] [mazk] [link]

Perform adaptive table lookup. Breakpoints relate the coordinate inputs to cell
locations in the table. The data is uzed to dynamically update the cell values at
these locations.

P |
F

First input [raw] breakpaint set:
J10.22.51.40)

Second input [column) breakpoint set;
J0z231.40]

[~ Make initial table am input
Table data [initial):
|[4 561613201018 23]

Table numbering data:

123456789

Adaptation method: ISampIe mean [with forgetting) ;I
Adaptation gain (0 ko 17

Jog

[ Make adapted table an output

[~ Add adaptation enable/disable/iaset port

[ &dd cell lack enable/disable part

Action for out-of-range input|lgrore LI

1] I Cancel | Help | Apply

First input (row) breakpoint set
The vector of values containing possible block input values for the
first input variable. The first input vector must be monotonically
increasing.

Second input (column) breakpoint set
The vector of values containing possible block input values for
the second input variable. The second input vector must be
monotonically increasing.
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Make initial table an input
Selecting this check box forces the Adaptive Lookup Table (2D
Stair-Fit) block to ignore the Table data (initial) parameter.
Instead, a new port appears with Tin next to it. Use this port
to input table data.

Table data (initial)
The initial table output values. This 2-by-2 matrix must be of size
(n-1)-by-(m-1), where n is the number of first input breakpoints
and m is the number of second input breakpoints.

Table numbering data
Number values assigned to cells. This matrix must be the same
size as the table data matrix, and each value must be unique.

Adaptation method
Choose Sample mean or Sample mean with forgetting. Sample
mean averages all the values received within a cell. Sample mean
with forgetting gives more weight to the new data. How much
weight is determined by the Adaptation gain parameter. For
more information, see “Selecting an Adaptation Method” on page
5-8.

Adaptation gain (0 to 1)
A number from 0 to 1 that regulates the weight given to new
data during the adaptation. A 0 means short memory (last data
becomes the table value), and 1 means long memory (average all
data received in a cell).

Make adapted table an output
Selecting this check box creates an additional output port for the
adapted table.

Add adaptation enable/disable/reset port
Add an input port that enables, disables, or resets the adaptive
lookup table.

Add cell lock enable/disable port
A port that provides the means for updating only specified cells
during a simulation run.
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Action for out-of-range input
Ignore or Adapt by extrapolating beyond the extreme breakpoints.
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Purpose

Description

Create adaptive lookup table of arbitrary dimension

2.0 T(u)

The Adaptive Lookup Table (nD Stair-Fit) block creates an adaptive
lookup table of arbitrary dimension by dynamically updating the
underlying lookup table. The block uses the outputs of your system to
do the adaptations.

Each indexing parameter may take a value within a set of adapting data
points, which are called breakpoints. Breakpoints in each dimension
define a cell. The set of all breakpoints in one of the dimensions defines
a grid. In the n-dimensional case, each cell has two n breakpoints and
is an (n-1) hypersurface.

You can use the Adaptive Lookup Table (nD Stair-Fit) block to model
time-varying systems.
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L]
DIO |Og E! Function Block Parameters: Adaptive Lookup Tz x|
Box — Adaptive Lookup Table [nD] [mazk] [link]

Perform adaptive table lookup. Breakpoints relate the coordinate inputs to cell
locations in the table. The data is uzed to dynamically update the cell values at
these locations.

P |
F

Mumber of table dimensions:
4
Table breakpaints [cell aray):

I{[1 0.22,31,40], [10,22, 31401

[~ Make initial table am input
Table data [initial):
|[4 561613201018 23]

Table numbering data:

123456789

Adaptation method: ISampIe mean [with forgetting) ;I
Adaptation gain (0 ko 17

Jog

[ Make adapted table an output

[~ Add adaptation enable/disable/iaset port

[ &dd cell lack enable/disable part

Action for out-of-range input|lgrore LI

ak. I Cancel Help Apply

Number of table dimensions
The number of dimensions for the adaptive lookup table.

Table breakpoints (cell array)
A set of one-dimensional vectors that contains possible block
input values for the input variables. Each input row must be
monotonically increasing, but the rows do not have to be the same
length. For example, if the Number of table dimensions is 3,
you can set the table breakpoints as follows:

{f1t 23], [57], [1357]}
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Make initial table an input
Selecting this check box forces the Adaptive Lookup Table (nD
Stair-Fit) block to ignore the Table data (initial) parameter.
Instead, a new port appears with Tin next to it. Use this port
to input table data.

Table data (initial)
The initial table output values. This (n-D) array must be of size
(n-1)-by-(n-1) ... -by- (n-1), (D times), where D is the number of
dimensions and n is the number of input breakpoints.

Table numbering data
Number values assigned to cells. This vector must be the same
size as the table data array, and each value must be unique.

Adaptation method
Choose Sample mean or Sample mean with forgetting. Sample
mean averages all the values received within a cell. Sample mean
with forgetting gives more weight to the new data. How much
weight is determined by the Adaptation gain parameter. For
more information, see “Selecting an Adaptation Method” on page
5-8.

Adaptation gain (0 to 1)
A number from 0 to 1 that regulates the weight given to new
data during the adaptation. A 0 means short memory (last data
becomes the table value), and 1 means long memory (average all
data received in a cell).

Make adapted table an output
Selecting this check box creates an additional output port for the
adapted table.

Add adaptation enable/disable/reset port
Add an input port that enables, disables, or resets the adaptive
lookup table.

Add cell lock enable/disable port
A port that provides the means for updating only specified cells
during a simulation run.
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Action for out-of-range input
Ignore or Adapt by extrapolating beyond the extreme breakpoints.
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spetool

Purpose

Syntax
Description

See Also

Open Simulink Parameter Estimation GUI

spetool('modelname’)

spetool('modelname') opens Simulink Parameter Estimation GUI for
the Simulink model with the name modelname.

For more information on estimating parameters using Simulink
Parameter Estimation GUI, see Chapter 1, “Getting Started”.
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acceleration 1-55
accelerator mode 1-55
adaptation gain 5-9
adaptive lookup tables 5-2
adding data sets 1-22

C

command-line estimation 6-3
Controls and Estimation Tools Manager 1-9

D

data
detrending 3-14
exclusion 3-5
filtering 3-14
preprocessing 3-3
Data Import dialog box 1-13
data sets
adding 1-22
detrending data 3-14
different time lengths 1-51
display options for estimation 1-26

estimation
display options 1-26
example of command-line estimation 6-5
from the command line 6-3
running 1-32
selecting parameters 1-16
selecting states 1-18
setting up a project 1-22
excluding data 3-5

F
filtering data 3-14

importing
initial conditions 1-14
transient data 1-11
initial conditions
example of estimating 2-4
importing 1-14
initial guesses 1-19

L

lookup tables
adaptive 5-2

M
multiple projects and tasks 4-2

o

optimization
setting options for 1-45

P

parameter estimation 1-55
parameters
selecting for estimation 1-16
specification of 1-24
preprocessing data 3-3

projects
definition of 1-7
saving 4-3

R

running an estimation 1-32

S

Sample mean 5-8
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Sample mean (with forgetting) 5-8 T
Sample mean with forgetting 5-9 transient data
saving projects 4-3 importing 1-11

selecting views 1-28
setting options

for optimization 1-45 U

for simulation 1-45 upper/lower bounds

upper/lower bounds 1-19 setting 1-19
simulation

setting options for 1-45 Vv

simulation with 1-50
specifying parameters 1-24
states

selecting for estimation 1-18

views
selecting 1-28
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